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Int roduct ion 

The California Central Valley Groundwater-Surface Water Simulation Model (C2VSim) is an integrated 
hydrologic model that simulates water movement through the Central Valley’s land surface, groundwater and 
surface water flow systems. The C2VSim model was developed within the Integrated Water Flow Model 
(IWFM).  IWFM simulates water movement through the land surface, groundwater and river systems, and uses 
a unique land-use-based approach to calculate water demand and optionally adjust groundwater pumping 
and/or surface water diversions to meet this demand. The C2VSim model contains monthly historical stream 
inflows, surface water diversions, precipitation, land use and crop acreages from October 1921 through 
September 2009. The model simulates the historical response of the Central Valley’s groundwater and surface 
water flow system to historical stresses, and can also be used to simulate the response to projected future 
stresses. C2VSim can be used for integrated regional water management plans, planning studies, groundwater 
storage investigations, assessing infrastructure improvements, evaluating ecosystem enhancement scenarios, 
conducting climate change studies, and assessing the impacts of changes to water operations. 

This tutorial gives an overview of the C2VSim model, the IWFM program, and several useful tools and 
applications. Its’ goal is to provide users with an understanding of C2VSim as they work with the model and 
modify the model to simulate fictitious case studies. The first section, Getting Started, describes all of the 
programs and files that will be used in the tutorial, where to get them, and how to install them in your 
computer. The second section gives a brief introduction to some of the programs that will be used. The third 
section shows how to run the C2VSim model. The next two sections cover how to import model results into 
Excel, how to use the C2VSim ArcMap Tool to view model results, and how to create animations with TecPlot.  

The final three sections are the heart of the tutorial, and provide detailed walkthroughs for simulating 
fictitious scenarios with the C2VSim model. In the first scenario, three groundwater wells are added to the 
simulation, and are used to pump water for agricultural use. In the second scenario, an aquifer storage and 
recovery program is simulated. In the third scenario, a groundwater-substitution water transfer program is 
simulated. These scenarios show how easy it is to use C2VSim to model proposed water resources projects. 

The C2VSim Model 

The California Department of Water Resources (DWR) has developed the C2VSim model, an integrated 
hydrologic model, as a tool to aid in water management planning. The C2VSim model simulates water 
movement through the interconnected land surface, surface water and groundwater flow systems in the 
systems in the 20,000 mi2 (51,000 km2) area defined by the alluvial Central Valley aquifer. The model includes 
a detailed database of monthly precipitation, land use, crop acreage, river inflow and surface water diversion 
information from October 1921 through September 2009. This information is used to calculate historical water 
use, groundwater pumping and changes in aquifer storage. 

The C2VSim model simulates the historical response of the Central Valley’s groundwater and surface water 
flow systems to historical stresses, and can also be used to simulate the effects of projected future stresses. 
The model can be used to estimate groundwater pumping rates, which are not measured or reported in the 
Central Valley. The model can also be used to understand water flows between rivers and groundwater 
aquifers, which are essential for evaluating the impacts of many conjunctive use and water transfer programs. 
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The C2VSim model is also the basis for the groundwater component of CalSim 3, a water resources planning 
model for simulating operation of the California State Water Project and Federal Central Valley Project 
developed in conjunction with the U.S. Bureau of Reclamation. 

C2VSim was developed using the California Department of Water Resources’ Integrated Water Flow Model 
(IWFM) application. IWFM couples a three-dimensional finite element groundwater simulation process with 
one-dimensional land surface, river, lake, unsaturated zone and small-stream watershed processes. C2VSim 
dynamically calculates crop water demands, allocates contributions from precipitation, soil moisture and 
surface water diversions, and calculates the amount of groundwater pumping required to meet the remaining 
demand. Model input was compiled from California Department of Water Resources’ extensive Central Valley 
land and water use data, which has been continuously collected since 1921. 

Required Computer Hardware and Software 

The tutorial will make extensive use of Excel, TextPad and ArcMap, and will also include a demonstration of 
TecPlot. These programs are described below. Instructions for downloading and installing TextPad and 
TecPlot, and extensions for Excel and ArcMap, are detailed in the next section. 

Excel (2007 or 2010) 

The C2VSim model has many input files containing time-series data. These are plain text files, and the data in 
these files is in a tab-delimited format. A spreadsheet program is an excellent tool for preparing and modifying 
these input data sets. It is very easy to open a file up in a text editor, copy a block of data from the file, and 
paste it into a spreadsheet, where the tab-delimited data will be automatically parsed into rows and columns. 
Similarly, a block of data copied from a spreadsheet can easily be pasted into a C2VSim input file. This tutorial 
uses Excel.  

DWR has developed several utilities that work with Excel to greatly facilitate reviewing model results. The 
IWFM Tools Add-In for Excel 2007-2010 adds a new tab to Excel named “IWFM Tools” that holds three 
utilities. One of these utilities will quickly import data from IWFM Budget binary files into Excel; this tool will 
be used extensively in this tutorial to analyze model results. Another tool exports data to text files without 
wrapping lines, and is useful when IWFM input data prepared in Excel must be exported to a text file with 
right-aligned data columns. The third tool can be used to convert time series data into a Water Year-by-Month 
table and optionally to generate charts, and is very useful in preparing reports and presentations of model 
results.  

ArcMap (10.0 or later) 

Geographical Information Systems (GIS) software is extremely useful for preparing model inputs and reviewing 
model results. ArcMap 10 will be used for this tutorial. DWR and RMC-WRIME have developed an ArcMap 
Tool, the C2VSim ArcGIS GUI, to analyze C2VSim model results. This tool will be used extensively in the 
tutorial.  
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TextPad 6 

The C2VSim model is a group of text files that run in the IWFM application. A text editor is required to view 
and modify these files. The IWFM and C2VSim developers have found that TextPad is a very versatile text 
editor with several useful features. These include the ability to create macros, block select mode, syntax 
highlighting and a tool to display the differences between two files. 

TecPlot 360 

TecPlot 360 is a visualization tool that can be used to visualize model results. The C2VSim model creates two 
files with the groundwater heads and land-surface subsidence values in a TecPlot-readable format. TecPlot can 
then be used to create animations or contour maps of groundwater heads and land-surface subsidence.  
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Gett ing Started 

This tutorial requires the use of a Windows computer with several programs and utilities installed. The tutorial 
exercises involve extensive use of three applications: Excel (2007 or 2010), TextPad and ArcMap 10. There is 
also a brief introduction to TecPlot. You should also download the C2VSim model files and the C2VSim ArcGIS 
files and place them in a convenient location.  

 

Download the C2VSim model files 

Go to http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm to download the 
C2VSim model files and documentation.  

Two versions of the model files are posted at the web site, C2VSim 3.02-CG Water Years 1922-2009 and 
C2VSim 3.02-CG Water Years 1973-2009. The main differences between the two versions are the starting date 
and the initial condition file. The version at C2VSim 3.02-CG Water Years 1922-2009 has an initial condition of 
October 1, 1921, and the version at C2VSim 3.02-CG Water Years 1973-2009 has an initial condition of 
October 1, 1972.  

Clicking on each of these links will download a zip file. Open the zip file to extract the model files and place 
them in a convenient location on your computer.  

This tutorial will use the version in C2VSim 3.02-CG Water Years 1973-2009 because it covers a shorter time 
period, and therefore takes less time to run. 

 

Download the Tutorial files 

Go to https://msb.water.ca.gov/cvwrsm/-/document_library/view/149277 and download the files posted there. 
Unzip each file and place the contents in a convenient place on your computer.  

The file Tools.zip also contains two TecPlot files, CVGWheadTecPlot.lay and CVSubsidenceTecPlot.lay. These 
can be placed in the Results folder of the C2VSim 3.02-CG Water Years 1973-2009 model version to view 
simulation results in TecPlot. 

Three of these files contain completed versions of the examples that will be worked in the tutorial. 
GWP_Example_Complete.zip contains a case study in which several additional groundwater pumping wells 
are added to the C2VSim model.  ASR_Example_Complete.zip contains a case study in which an aquifer 
storage and recovery program is simulated using the C2VSim model. GST_Example_Complete.zip contains a 
case study in which a groundwater-substitution water transfer program is simulated using the C2VSim model. 
Your modified files can be compared to the files in these completed examples, or you can simply follow along 
using the completed examples if you do not feel comfortable modifying the input files yourself. 

http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm�
https://msb.water.ca.gov/cvwrsm/-/document_library/view/149277�


C2VSim Hands-On Tutorial DRAFT: Not for Public Release 1/22/13 

10 
 

Download and install the C2VSim ArcMap GUI 

Go to http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm to download the 
ArcGIS Tool installer and ArcGIS files for use with this tool. This tool was developed for Windows 7 and 
ArcMap 10.0 or 10.1. 

The Tool installer link will download the installer program C2VSim_ArcGIS_GUI_Setup.exe. Run this program 
to install the C2VSim ArcMap Tool. Quit ArcMap before this installation. You may need to install additional 
programs, such as .Net, if they are not already installed on your computer. 

The ArcMap GUI was developed to work with ArcMap 10 running under Windows 7. Every effort has been 
made to configure the installer to work with most computers. However, conflicts can occur with other installed 
programs. If you encounter problems installing the ArcMap GUI, please email the ArcMap GUI developer at 
IWFMtechsupport@water.ca.gov detailing your problems.  

After running the installer, open ArcMap. The C2VSim GUI tool icon should be in the menu bar:  

If you do not see the C2VSim GUI tool icon, go to the Customize menu, select ‘Customize Mode…’, and then 
the ‘Commands’ tab. Scroll down in the Categories window and select ‘C2VSim GUI’. Drag the ‘C2VSim GUI’ 
item from the Commands window to the toolbar. 

 

Two versions of the ArcGIS files are available from the web site. ArcGIS Files: C2VSim 3.02-CG Water Years 
1922-2009 corresponds to the model files in C2VSim 3.02-CG Water Years 1922-2009 with an initial condition 
of October 1, 1921. ArcGIS Files: C2VSim 3.02-CG Water Years 1973-2009 corresponds to the model files in 
C2VSim 3.02-CG Water Years 1973-2009 with an initial condition of October 1, 1972. Each of these ArcGIS 
files includes an MXD file; double-click on this MXD file to load the associated data set into ArcMap. 

 

http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm�
mailto:IWFMtechsupport@water.ca.gov�
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Download and install the IWFM Excel Tools 

Go to http://baydeltaoffice.water.ca.gov/modeling/hydrology/IWFM/SupportTools/index_SupportTools.cfm. 
Click on the link IWFM Tools Add-in for Excel 2007-2010 and install the tool.  After the installer finishes, open 
Excel and look for the “IWFM Tools” tab. These tools were developed for Windows 7 and Excel 2007 or 2010. 

This utility will be used to analyze the results of the tutorial examples. After downloading the setup file, 
double-click it and follow the instructions for installation. Every effort has been made to configure the installer 
to work with most computers. However, conflicts can occur with other installed programs. If you encounter 
problems installing the IWFM Tools, please email the developer at IWFMtechsupport@water.ca.gov detailing 
your problems. 

 

Download and install TextPad 

Go to http://www.textpad.com/download/index.html. Download the installer, and install an evaluation copy of 
TextPad 6 on your computer.  This is a sophisticated text editor with several advanced features. TextPad be 
used extensively throughout the tutorial. You may also choose to use a different text editor that you are more 
comfortable with. 

 

Download and install TecPlot, and get a 3-day trial license 

Go to http://www.tecplot.com/downloads/free-trial-software/. Create a user account and sign in to download 
Install an evaluation version of the Tecplot 360 program. You can request a 3-day evaluation license. Do not 
request this license until you are ready to do the TecPlot examples, so it will work when you are doing them! 

This program will be used to visualize the change in groundwater heads and land-surface subsidence.  

http://baydeltaoffice.water.ca.gov/modeling/hydrology/IWFM/SupportTools/index_SupportTools.cfm�
mailto:IWFMtechsupport@water.ca.gov�
http://www.textpad.com/download/index.html�
http://www.tecplot.com/downloads/free-trial-software/�
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Software tools 

This section provides brief tutorials on the IWFM Excel Tools, TextPad and TecPlot. 

IWFM Excel Tools 

Three Excel add-ins that are useful when preparing IWFM input files and reviewing IWFM results are available 
from the DWR web site. This section explains how to use these tools. 

Space-delimited Text Exporter 

Sometimes we wish to export data from Excel to a space-delimited file, with right-justified data columns. Excel 
allows users to save as ‘Formatted Text (Space delimited) (*.prn)’. However, this option cuts the file into 
blocks approximately 240 characters wide, so it is not suitable for large data sets. The IWFM Space-delimited 
Text Exporter will export large data sets to space-delimited text files without chopping the data into blocks or 
word-wrapping long lines. 

To use this tool, first select the area to be exported using the cursor. Clicking on the ‘Space Delimited Text’ 
button brings up the standard Excel ‘Save As’ dialog, with the type ‘Space delimited text (*.prn)’ and the 
default file name ‘Output.prn’. 

 

This window can be used to navigate to the folder where the new file is to be saved and to provide a name for 
the file. (The file extension can be changed from ‘prn’ to something else, such as ‘txt’, by enclosing the entire 
file name in double quotes.) When the ‘Save’ button is pressed, a dialog window opens with the column with: 
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Enter the preferred column width, and press the ‘OK’ button. The dialog box will show the progress of the file 
conversion, and then close when the conversion is complete. 

 

 

Water-Year Table Maker 

The C2VSim model contains input data for water years 1922-2009. A water year runs from October 1 of the 
previous year to September 30; for example, water year 2009 is October 1, 2008 to September 30, 2009. It is 
often convenient to summarize input and output data by water year for reports and presentations. However, 
Excel’s standard formulas only work for calendar years. Water data must often be converted between units of 
cubic feet per second (cfs) and acre-feet, and between acre-feet (AF), thousand acre-feet (TAF) and million 
acre-feet (MAF), which require conversion factors that are not standard in Excel. The WY-Month tool was 
created to tabulate time-delimited data by water year and to convert data between cfs, AF, TAF and MAF. 

Clicking the ‘WY-Month’ button in the IWFM Tools ribbon brings up the ‘WY-Month’ window. 
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Click in the ‘Data Range’ area and use the cursor to select the dates, click in the ‘Time Series Data Range’ area 
to select the data, and then click in the ‘Output Range’ area and select a single cell in an empty region of a 
worksheet where the new table will be created. Optionally use the ‘Unit Conversion’ section by selecting the 
current units of the data under ‘Time Series Data’ and the desired output units under ‘Table’. Use the section 
at the bottom of the window to choose formatting options (the number of decimal places to show, and 
whether to use a 1000’s separator), and to add optional charts (monthly averages and annual totals). Click 
‘OK’ to create the table and the optional charts. 

The resulting table has the water year in the left-most column, monthly values for October through September 
in the central columns, and the water-year total in the right-most column. Rows for the average, maximum 
and minimum monthly and water-year values are added to the bottom of the table.  
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Budget-to-Excel 

The IWFM Budget program reads binary files produced by the Simulation program, and produces space-
delimited budget tables. The Budget-to-Excel tool runs the Budget program within Excel, and imports the 
resulting budget tables to Excel workbooks. This makes it easy to analyze, tabulate and graph model results. 

Before using this tool, run the IWFM Simulation program and check that the Simulation binary output files are 
present in the Results folder; Excel will crash if this tool is used when the binary files are not present.  

To use this tool, first create a new, blank Excel workbook. Next, in the ‘Budget to Excel’ panel of the ‘IWFM 
Tools’ ribbon, use the ‘IWFM version’ drop-down menu to select ‘3.02’. 

 

This will open the ‘Budget to Excel (3.02)’ dialog box with the word ‘Ready…’ in the lower left corner.  

 

Click the ‘Browse…’ button and navigate to the Budget folder of your C2VSim model run, and select the 
budget input file. The word in the lower left corner will change to ‘Importing…’ as the budget input file and 
the binary files produced by the Simulation program are read, and then shows a list of the available budget 
tables in the window below ‘Choose Budget Table’. This window shows seven budget tables; this tool does 
not currently work with the ‘Diversion details budget’; do not choose this budget table or Excel will quit. 

 

Select the budget table to be imported, and then click the ‘Transfer to Excel’ button. The budget tables will be 
loaded into the Excel workbook, with one worksheet for each table. For tables organized by subregion, there 
will be one tab for each subregion. There will be one tab for each river reach in the Stream Reach Budget, one 
tab for each lake in the Lake Budget, and one tab for each small-stream watershed in the Small Watershed 
Budget.  
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After importing a budget table, save the workbook with an appropriate name. Always open a new blank 
workbook before importing another budget table.  
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TextPad 

This section contains a brief introduction to TextPad and some of the key features that are useful in preparing 
and modifying C2VSim files. Open the TextPad program and explore the tools discussed here. 

TextPad Tools 

Comparing files 
Open two files in TextPad. Select Tools -> Compare Files or use the command <Ctrl-F9>. 

 

This will open the compare files command window. 

 

Click “OK” and TextPad will display the differences between the two files. Here’s an example from one of the 
tutorial cases: 
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The file lines that are different are preceded by either ‘<’ or ‘>’ to specify which file they are in. 

Block select mode 
There are two ways to turn block select mode on: through the menus via Configure-> Block select mode, and 
with the key combination <Ctrl-Q> B. 

 

Block select mode allows the user to select a block of text. This block can be copied or cut, and search-and-
replace operations can be confined to the selected block of text. This is very useful for extracting data from 
files. 

 

 

Syntax highlighting 
TextPad can optionally highlight syntax in files, using the file extension to choose the highlight style. The 
example below shows syntax highlighting in a batch file, with the keyword ‘pause’ highlighted in blue. 

 

Syntax highlighting options can be adjusted by selecting Configure -> Preferences -> Document classes: 
syntax highlighting.  
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Syntax highlighting rules are contained in syntax files. Many TextPad syntax files are available. Several are 
listed below. For C2VSim, we generally use the dosBat.syn file to activate batch file syntax highlighting. 

 

Commonly Used TextPad Commands 

Find  <F5> 
Find and replace <F8> 
Compare files <Ctrl-F9> 
Block-select <Ctl-Q>B 
Record a Macro <Ctrl-Shift-R> 
Run the Macro <Ctrl-R> 
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C2VSim ArcGIS GUI 

This section gives a brief overview of the C2VSim ArcGIS GUI, focusing on the components that will be used in 
the tutorial. A more detailed explanation of this tool is available in the C2VSim ArcGIS GUI User’s Manual, 
which is available under the tools’ Help menu. 

Starting the C2VSim ArcGIS GUI 

The first step you must take when you start the C2VSim ArcGIS GUI tool is to tell the tool which files to use. 
For this tutorial, we will always open the MXD file before opening the tool.  

When the MXD file is open, click the C2VSim ArcGUI GUI icon in the menu bar:  This opens the 
window: 

 

To view a PDF version of the C2VSim ArcGIS GUI, select the ‘Help’ menu and then ‘User’s Manual’. 

To link the tool to the current MXD file, click the ‘File’ menu and select ‘Use Current’. 

  



C2VSim Hands-On Tutorial DRAFT: Not for Public Release 1/22/13 

21 
 

Graphing C2VSim results 

Before we can create a graph, we have to display and 
select an object that is associated with the item we want 
to graph. For example, if we want to graph data 
associated with a river reach, we must first turn on the 
StreamReaches coverage, and then select the river reach 
or reaches we want to use. The C2VSim ArcGIS GUI 
requires one additional step: we must make the layer we 
are interested in the only selectable layer. For the 
StreamReaches coverage, we do this by right-clicking on 
the StreamReaches layer in the Table of Contents 
window, choose ‘Selection’ from the drop-down menu, 
and then choose ‘Make This The Only Selectable Layer’ 
from the drop-down sub-menu. Later, if we want to graph 
data associated with subregions, we have to first make 
the Subregion layer the only selectable layer. 

 

Select the ArcMap ‘Select Features by Rectangle’ tool (the white arrow). Use this to select a river reach. Then, 
click on the ‘Graph’ button in the C2VSim ArcGIS GUI to open the ‘Time Series Graph’ window. Select the 
budget table in the ‘Time Series table’ drop-down menu, then choose a category in the ‘Sub-Data Type Name’ 
drop-down menu, and optionally choose a date range. Click on the ‘OK’ button to produce the graph. 
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TecPlot 

TecPlot is a powerful graphics program with numerous capabilities for viewing and displaying model output. 
In addition to the ability to make two-dimensional color-map and contour graphs, TecPlot can easily animate 
time series, and can generate three-dimensional color-maps with interior slices. The tutorial exercises explore 
only the two-dimensional capabilities. 

Layer files 

TecPlot uses layer files to store graphical configuration information. Each layer file contains the name and 
structure of an associated data file. Two TecPlot layer files are available in the Tools folder. These two files are 
associated with the C2VSim 3.02-CG Water Years 1973-2009 version of the C2VSim model. Layer file 
CVGWheadTecPlot.lay uses the simulation results in the file CVGWheadTecPlot.out. Layer file 
CVSubsidenceTecPlot.lay uses the simulation results in the file CVSubsidTecPlot.out. 

To run TecPlot, copy these two files to the Results folder of the C2VSim 3.02-CG Water Years 1973-2009 
folder, and then double-click on one of the layer files. It should open the TecPlot program and display a color 
map of the selected data (heads or land-surface subsidence). It may take a few moments to load the file. 

This tutorial will use the layer file CVGWheadTecPlot.lay for the 1973-2009 model. TecPlot will open and 
display the color map of the initial water table. (All dates in the C2VSim model are for the end of a time 
period. The initial condition is for midnight 9/30/1972, which is equivalent to the start of 10/1/1972.) The 
legend has the name of the output file data set ‘GWHEAD1’, which corresponds to the groundwater head of 
model layer 1. 
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Choose the ‘Data’ menu, then ‘Data Set Info…’ to display a window showing the data sets in the data file. 

 

The ‘Zone/Variable Info’ tab shows that this data file has five pieces of data for each pint: the X and Y 
locations and the values of GWHEAD1, GWHEAD2 and GWHEAD3, for each month from 9/30/1972 to 
9/30/2009. We can also see information about each variable by selecting it in the right panel. 

Under the ‘Options’ menu, make sure the Standard sidebar is checked. This will make the left panel visible,  
exposing several useful commands. Place a check box next to ‘Mesh’ to display the finite element mesh. 
Remove the check mark next to ‘Edge’ to remove the rivers. 

 

Contour colors 

Click the box to the right of ‘Contour’ in the sidebar to open the ‘Contour $ Multi-Coloring Details’ dialog. Use 
the drop-down menu to choose which data set to display (GWHEAD1 is the water table, GWHEAD2 is the 
upper confined zone, and GWHEAD3 is the lower confined zone).  

 

Click in the box to the right of the drop-down menu (labeled ‘>>’) to display the color map options. The 
‘Levels’ tab controls the numbering in the legend. The ‘Coloring’ tab controls the range of color values; click 
the box to the right of the grayed-out ‘Use Color Map Group’ to change the colors. The ‘Legend’ tab controls 
the formatting of the legend. 
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Animation 

To create a movie of the change in groundwater head, select the ‘Animate’ menu and then ‘Zones…’. This 
opens the ‘Animate Zones’ dialog box. 

 

Use the ‘Start Zone’ and ‘End Zone’ drop-down menus to choose the starting and ending dates of the 
animation. Set the ‘Zone Skip’ value to the number of months in each frame (generally 1, 2, 3, 6 or 12). Use 
the ‘+’ and ‘-‘ buttons next to ‘Current Zone’ to review the display for individual time steps. Use the ‘Animate’ 
drop-down menu to select whether you want to see the animation on the screen, or want to generate a movie 
file. Generally it’s best to view the animation on-screen until you are satisfied, then save is as a WMV file (or 
another file type). 

Display options 

Clicking on the ‘Zone Style’ button will open the ‘Zone Style’ window, shown below. In TecPlot, each time step 
in the C2VSim output is a separate zone. This window controls how the data will be displayed, for example 
whether a color map or contour lines (or both) will be displayed. The graphical options for the C2VSim data 
sets are under the ‘Contour’ tab. The ‘Zone Show’ column controls what ‘zone’ is visible. To display the map 
for a different date, select the date row then left-click the ‘Zone Show’ title box and choose ‘Show Selected 
Only’. To change the display from a color map to contours, click the ‘Contour Type’ title box and choose 
‘Lines’, then click the ‘Line Color’ title box and choose ‘Multi1’ in the lower left corner. 
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Using the C2VSim Model 

The C2VSim model is run from the command line using the four IWFM programs Preprocessor, Simulation, 
Budget and Z-Budget.  

Integrated Water Flow Model (IWFM) 

The Integrated Water Flow Model (IWFM) is a water resources management and planning model that 
simulates groundwater, surface water, stream-groundwater interaction, and other components of the 
hydrologic system. IWFM models groundwater flow as a quasi three-dimensional system and solves the 
governing flow equation using the Galerkin finite element method. A unique feature of IWFM is the land use 
based approach of calculating water demand. IWFM simulates stream flow, soil moisture accounting in the 
root zone, flow in the vadose zone, groundwater flow, and stream-aquifer interaction. Agricultural and urban 
water demands can be pre-specified, or calculated internally based on different land use types. Water re-use is 
also modeled as well as tile drains and lakes or open water areas. Another notable feature of IWFM is a “zone 
budget” type of post-processor that includes subsurface flow computations across element faces. IWFM was 
developed by staff in the Modeling Support Branch of the Bay-Delta Office who is responsible for its technical 
support.  

All IWFM input files are text files. The control files for the IWFM programs use the extension ‘.in’, and all other 
files use the extension ‘.dat’. The IWFM programs produce text files with the extensions ‘.out’ and ‘BUD’, and 
binary files with the extension ‘.bin’. The binary files are read by other IWFM programs. 

IWFM input files also support the inclusion of comments within the files. This allows each file to contain 
documentation describing the sources, units, assumptions, etc. for the data in the file. Lines that begin with 
the ‘C’, ‘c’ or ‘*’ character in the first character position are treated as comments and are ignored by the Pre-
processor program. 
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Running C2VSim 

The C2Vsim model is run with four IWFM programs. We will run the C2VSim 3.02-CG Water Years 1973-2009 
version of the model in this tutorial. Most of the input files are identical to the C2VSim 3.02-CG Water Years 
1922-2009 version of the model, with the exception of the initial conditions file and a few lines in the 
preprocessor control file. 

This tutorial will give brief explanations of some C2VSim input files. See the C2VSim User Manual, available at 
the C2VSim web site http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm, for 
detailed descriptions of the input files, including data sources and any assumptions used in compiling the 
data. 

A typical C2VSim run involves executing the Preprocessor, Simulation and Budget programs one time each in 
sequence, and then executing the Z-Budget program one or more times to produce budgets for different user-
defined zonal configurations. Each program can accept the name of the corresponding main input file on the 
command line. The following example shows how the IWFM programs are executed for a C2VSim run. These 
commands are usually written to a batch file so all of the programs can be easily executed in sequence. 

 > Preprocessor3_02 CVPreproc.in 

 > Simulation3_02 CVSim.in 

 > Budget3_02 CVBudget.in 

 > Zbudget3_02 ZBudget_All.in 

 > Zbudget3_02 ZBudget_HRs.in 

 > Zbudget3_02 ZBudget_SRs.in 

 > Zbudget3_02 ZBudget_Elem.in 

 > Zbudget3_02 ZBudget_Elem_L1.in 

 > Zbudget3_02 ZBudget_Elem_L3.in 

 > Zbudget3_02 ZBudget_Elem_L2.in 

 

  

http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm�
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The Preprocessor program 

The Preprocessor program compiles the model framework (nodes, elements, rivers, lakes, specified wells, etc.) 
and produces a binary output file that is read by the Simulation program. 

We will examine several preprocessor input files before running the preprocessor program. 

Open the Preprocessor folder. 

Preprocessor Control File 
Open CVpreproc.in with TextPad. 

The preprocessor control file CVpreproc.in contains four sections. The first section has three lines describing 
the model version that are read by the Preprocessor program and written to the output log file 
PreprocessorMessages.out. The second section lists the files that are used by the Preprocessor program. 
The third section contains two flags to select output options. The units and factors to be used to convert 
simulation length and area units to output units are listed in the final section. 

The Preprocessor program uses the following files: 

No. File Name Type File Contents 
4 CVpreout.bin Binary Output file (binary format) 
5 CVpreproc.in Text Main input file 
7 CVelement.dat Text Element and node specification 
8 CVnode.dat Text Nodal x-y coordinates 
9 CVstrat.dat Text Aquifer stratigraphy 

10 Cvrivers.dat Text River network configuration 
11 CVlake.dat Text Lake configuration 
12 Cvwells.dat Text Well locations and characteristics 
13 CVcharac.dat  Text Element hydrologic characteristics 

 

Other Files 
Open several of the input files, including CVnode.dat, CVelement.dat, CVstrat.dat and CVriver.dat, 
and review their contents. The C2VSim User Manual contains detailed explanations of the contents and data 
sources for each of these files.  

Run the Preprocessor program 

Find the file Run_Preprocessor.bat and open it with TextPad (either right-click on the file and choose 
TextPad, or drag it onto an open TextPad window; double-clicking will run the commands in the batch file). 
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The first item ‘..\bin\PreProcessor3_02.exe’ points to the Preprocessor program in the bin directory, and the 
second item is the name of the Preprocessor input file. The ‘pause’ command in the second line causes the 
command window to remain open so the user can see if the program ran to completion. 

Close the file. 

Double-click Run_Preprocessor.bat to run the Preprocessor program. 

Review Preprocessor results 

The Preprocessor program produces two output files. The binary file CVpreout.bin is read by the Simulation 
program. The file PreprocessorMessages.out lists properties of the model finite element grid, rivers and 
specified wells. 

Open the file PreprocessorMessages.out with TextPad.  

The first section of PreprocessorMessages.out repeats the three title lines from the Preprocessor control 
file. The second section lists the input file names. The third section lists the model subregions and model 
properties. Next, the model nodes, elements, and stratigraphy are listed. This is followed by a listing of the 
river nodes, including the river reaches, ground surface altitude at each river node, and invert (river bottom) 
altitude. The last section provides a list of the specified wells, followed by the apportionment of pumping at 
each well to the model layers. 
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The Simulation program 

The Simulation program reads the CVpreout.bin file produced by the Preprocessor program, then reads a 
number of specification and time-series data files to simulate the evolution of the hydrologic system through 
time. The program produces binary files read by the Budget and Zbudget programs, and several types of text 
files. The text files include a log file; groundwater, surface water, tile drain and subsidence hydrograhs; 
average subregion evapotranspiration; TecPlot data files; the groundwater heads at each node for each time 
step; and the final condition. All of these text files can be read with a text editor.  

CVSim.in 
Open the Simulation program control file CVSim.in with TextPad. 

The file CVSim.in has seven sections. The first section has three lines describing the model version that are 
written to the output log file SimulationMessages.out. The second section lists the input and files used by 
the Simulation program and the output files it produces. The third section contains the starting and ending 
times and the time step (in HEC-DSS format). This is followed by sections for output and debugging options, 
output units, solver controls, and controls specifying the water budget calculation method. 

The following table lists the input files in the Simulation program control file CVsim.in. This includes the 
binary file produced by the Preprocessor program and 21 text files with the ‘.dat’ extension. (The 
CVpreout.bin file is usually in the Preprocessor folder, and the name usually includes the path to the file.) 

No. File Name Type File contents 
5 CVpreout.bin Binary Binary input generated by pre-processor 
7 CVparam.dat Text Hydrologic parameters 
8 CVbound.dat Text Boundary condition data file 
9 [not used] Text Time series boundary conditions data file 
10 CVprint.dat Text Print control file 
11 CVinit_1972.dat Text Initial aquifer heads and pre-consolidation heads 
12 CVsupplyadj.dat Text Supply adjustment specification data file 
13 CVlanduse.dat Text Land use data file 
14 CVcropacre.dat Text Crop acreage data file 
15 CVprecip.dat Text Precipitation data file 
16 CVevapot.dat Text Evapotranspiration data file 
17 CVtiledrn.dat Text Tile drain specification data file 
18 CVurbanspec.dat Text Urban water use specification data file 
19 [not used] Text Agricultural water supply requirement data 
20 CVurbandem.dat Text Urban water demand file 
21 CVinflows.dat Text River inflow data file 
22 CVcropdem.dat Text Crop demand data file 
23 CVPuSp.dat Text Pumping specification data file 
24 CVpump.dat Text Pumping data file 
25 Cvdivspec.dat Text Surface water diversion specification file 
26 CVdiversions.dat Text Surface water diversion data file 
27 CVIrFr.dat Text Irrigation fraction data file 
28 CVmaxlake.dat Text Maximum lake elevations data file 
29 CVruf.dat Text Irrigation water re-use factor data file 
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Each of the other C2VSim input files is a text file containing a specific type of data. For example, the diversion 
specification file CVdivspec.dat lists all of the surface water diversions, including the source river node, 
destination subregion and land use type (agricultural or urban), evaporative and seepage loss fractions, and 
the data column of the file CVdiversions.dat that holds the diversion volumes. Each of these files is 
explained in detail in the C2VSim User Manual.  

The following table lists the Simulation program output files. This includes one binary file (CVZB.bin) used by 
the Zbudget program, eight binary files used by the Budget program, and nine text files. Most of the output 
files are written to the Results folder, and the name usually includes the path to the file.) The Simulation 
program also produces a log file, SimulationMessages.out, as it runs. 

No. File Name Type File contents 
31 CVZB.bin Binary Binary output for groundwater zone budget 
32 CVsmwshed.bin Binary Binary output for small watershed flow components 
33 [not used] Binary Binary output for element sub-group details 
34 Cvdiverdtl.bin Binary Binary output for diversion details 
35 CVstreamrch.bin Binary Binary output for stream budget by reach 
36 CVlake.bin Binary Binary output for lake budget 
37 CVlandwater.bin Binary Binary output for land and water use budget 
38 CVstream.bin Binary Binary output for stream budget 
39 CVrootzn.bin Binary Binary output for root zone moisture budget 
40 Cvground.bin Binary Binary output for groundwater budget 
41 CVSubsHyd.out Text Subdicence hydrograph output file 
42 CVAvgET.out Text Virtual crop characteristics output file 
43 [not used] Text Element face flow output file 
44 [not used] Text Boundary flow output file 
45 CVtiledrn.out Text Tile drain/subsurface irrigation hydrograph 
46 CVSWhyd.out Text Stream flow hydrograph 
47 CVGWhyd.out Text Groundwater level hydrograph 
48 CVGWheadall.out Text Groundwater level output at every model node 
49 [not used] Text Layer vertical flow 
50 CVGWheadTecPlot.out Text Groundwater heads for TecPlot 
51 CVSubsidTecPlot.out Text Subsidence output for TecPlot 
52 CVfinallist.out Text Final simulation results 

 

CVprint.in 
Open the Simulation program print file CVprint.dat with TextPad.  

Most of the Simulation program output files always contain the same kind of information presented in the 
same format. The user has control over the hydrographs printed by the file, and controls these through the 
print file CVprint.dat. 

The print file has six sections. The first section contains a list of the groundwater hydrograph locations, 
specified by either a node number or X-Y location. Stream hydrograph locations are specified by river node 
number in the second section. Tile drain hydrograph locations are listed in the third section. The fourth section 
has subsidence hydrograph locations, specified by either a node number or X-Y location. The final two 
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sections, boundary node flow hydrographs and element face flow hydrographs, are not used in the C2VSim 
model.  

Any information to the right of that required by the Simulation program is ignored. Comments can be added to 
the right of each specified hydrograph. In the CVprint.dat file, comments have been added for each of the 
hydrographs listing, for example, the observation well or stream gage that corresponds to the hydrograph. 

Close the CVprint.dat file.  

 

Running the Simulation program 

Find the file Run_Simulation.bat and open it with TextPad.  

 

The contents and format are similar to the Run_Preprocessor.bat file described above. The first item 
‘..\bin\Simulation3_02.exe’ points to the Simulation program in the bin directory, and the second item is the 
name of the Simulation input file. The ‘pause’ command in the second line causes the command window to 
remain open so the user can see if the program ran to completion. 

Close the file. 

Double-click Run_Simulation.bat to run the Simulation program. 

Review Simulation results 

The Simulation program produces nine binary files and nine text files, listed above, and the log file 
SimulationMessages.out. The log file and final conditions file (CVfinallist.out) are written to the 
Simulation directory, and the other files are written to the Results directory.  

Simulation log file 
Open SimulationMessages.out with TextPad. 

The first section of SimulationMessages.out repeats the three title lines from the Simulation control file. If 
the value of KDEB in the Simulation control file was set to 1, then the next section will list the aquifer 
parameter values for each node. The next section has the solver messages for each iteration and time step. 
The last line gives the total run time for the Simulation program. 

Close SimulationMessages.out. 
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Final conditions 
Next, open the file CVfinallist.out with TextPad. 

The CVfinallist.out file has the final groundwater heads, unsaturated zone water content, root zone water 
content, etc. for the simulation. This is stored in the same format as an initial condition file, so this final 
condition can be used as the initial condition for a subsequent model run.  

The TextPad ‘Find’ can be used to quickly review this file. Press the <F5> key, then enter a capital ‘C’, a space, 
5 stars and another space (“C ***** “), then press the return key. These characters are repeated at the 
beginning of each section of this file. Once this character string is entered in the ‘Find’ command, we can use 
<Ctrl-F> to move to the occurrence of this string.  

The first line that begins with “C ***** “ lists the simulation time step number. The second line that begins 
with “C ***** “ is the start of the groundwater heads section. The next sections are the root zone soil 
moisture for each subregion and land use type, unsaturated zone water content for each element, small-
stream watershed soil moisture and groundwater content, lake surface elevations, and finally the interbed 
thickness and preconsolidation head value at each groundwater node.  

Results directory 
The remaining Simulation output files are in the Results directory. Move up one level and then down into the 
Results directory. 

Compare the list of .out and .bin files in CVsim.in (and the table above) to the files in the Results folder. 

CVGWhyd.out 
Open the file CVGWHyd.out with TextPad. 

The groundwater hydrographs specified in the CVprint.dat file are written to the CVGWHyd.out file.  

The CVprint.dat file specifies 1387 groundwater hydrograph locations. The CVGWHyd.out file has one 
column with the date and 1387 columns for the groundwater hydrographs. The header lines at the top of the 
file list the aquifer layer and element of each hydrograph. The left-most column contains the time step in HEC-
DSS format with the month, day, year, underline character, and the hour. For example, the first time step is 
“10/31/1972_24:00“.  

 

 

The Budget program 

The Budget program reads binary files produced by the Simulation program and creates budget tables. For 
each binary file, the Budget program produces a text file with the same root name and the extension ‘.BUD’. 
For example, when it reads the groundwater budget binary file CVground.bin, it produces the groundwater 
budget text file CVground.BUD. 
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The Budget program is in the Budget directory. From the Results directory, move up one level, and then down 
into the Budget directory. 

Budget Control File 
Open CVBudget.in with TextPad. 

The budget control file CVBudget.in contains five sections. The first section lists the files that are used by 
read Budget program. The second section lists output unit names and conversion factors to convert from 
model units (feet) to budget output units (for example, acres or acre-feet). The next sections have the cache 
size and output control options. The final section lists the subregions names and print options. These are 
explained in more detail in the C2VSim User Manual. 

No. File Name Type File contents 
1 CVlandwater.bin Binary Land And Water Use Budget  
2 CVstream.bin    Binary Streamflow Budget 
3 CVrootzn.bin    Binary Root Zone Moisture Budget 
4 CVground.bin    Binary Groundwater Budget 
5 [not used] Binary Element Sub-Group Details  
6 CVsmwshed.bin   Binary Small Watershed Flow Components 
7 CVlake.bin      Binary Lake Budget 
8 CVstreamrch.bin Binary Stream Budget By Reach  
9 CVdiverdtl.bin  Binary Diversion Details   

 

Close the CVBudget.in file. 

 

Run the Budget program 

Open the file Run_Budget.bat with TextPad. 

 

The contents and format are similar to the Run_Preprocessor.bat file described above. The first item 
‘..\bin\Budget3_02.exe’ points to the Budget program in the bin directory, and the second item is the name of 
the Budget input file. The ‘pause’ command in the second line causes the command window to remain open 
so the user can see if the program ran to completion. 

Close the file. 

Double-click Run_Budget.bat to run the Budget program. 
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Review Budget results 

The Budget program reads eight binary files and produces eight text files for the C2VSim model (listed above) 
and the log file BudgetMessages.out. The log file is written to the Budget directory, and the others are 
written to the Results directory.  

Budget log file 
Open BudgetMessages.out with TextPad. 

The BudgetMessages.out does not contain much information. There is a message stating that the program 
ran successfully, and the run time.  

Close BudgetMessages.out. 

Results directory 
The remaining Budget output files are in the Results directory. Move up one level and then down into the 
Results directory. 

Compare the .bin and .BUD files in CVBudget.in (and the table above) to the files in the Results folder. For 
each .bin file (with the exception of CVZB.bin, used by the ZBudget program), there should be a 
corresponding .BUD file with the same root name. 

CVground.BUD 
Open the Groundwater Budget File CVground.BUD with TextPad. 

The Groundwater Budget File has 22 tables, one for each of the 21 model subregions, and one (labeled 
‘Subregion 22’) summarizing the groundwater budget for the entire model area. Each table begins with three 
title lines listing the IWFM version, the budget and subregion, and the subregion area. This is followed by a 
three-line table header with column titles. The third line of this header contains either a (+) or a (-) symbol, 
indicating the flow direction for the items in this column.  

The groundwater budget table format is identical for the 21 subregions and the model area (subregion 22). 
There are 16 columns: the date and time, 13 flow terms, the discrepancy (error for the time step), and the 
cumulative subsidence volume. Each line has a complete water balance, with the 13 flow terms and the 
discrepancy adding to zero. 

The characters 'IWFM' are repeated at the beginning of each subregion section, making it easy to step through 
the file. We can use ‘Find’ to quickly move through the file. Press the <F5> key and enter the letters ‘IWFM’, 
then his return. Then use <Ctrl-F> to move to the title are for each model subregion. 

We can also explore this table and the other budget tables with the IWFM Excel Tools and C2VSim ArcGIS 
GUI. 

Close the CVground.BUD file. 

You can repeat this for the other budget files.  
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The Z-Budget program 

The ZBudget program uses information in the CVZB.bin file to create budget tables for user-specified aquifer 
zones. The elements in these zones are specified in a ZBudget control file. Several Zbudget control files with 
different zonal configurations are distributed with the C2VSim model, and are listed in the table below.  

File Zones 
zbudget_SRs.in Subregions 
zbudget_HRs.in Hydrologic regions 
zbudget_all.in Model area (one zone) 
ZBudget_Elem.in Individual elements 
ZBudget_GWBasins_All.in Groundwater basins (B116) 

 

The ZBudget control files are in the ZBudget directory. Move up one level from the Results directory and then 
down into the ZBudget directory. 

 

ZBudget_SRs.in 
Open the ZBudget program control file ZBudget_SRs.in with TextPad. 

The file ZBudget_SRs.in ZBudget control file specifies 21 zones identical to the 21 model subregions. The 
ZBudget_SRs.in file has four sections. The first section lists the input binary file produced by the Simulation 
program, and three output control items. A key output control option is the value of ZEXTENT: if ZEXTENT = 0 
then the layer is specified for each zone, and if ZEXTENT = 1 then the zone includes all aquifer layers. The 
second section contains the starting and ending times (in HEC-DSS format). The third section lists the 
elements, the positive integer zone number each element is in, and (if ZEXTENT = 0) the model layer in that 
zone. ZEXTENT = 1 for this file, so this section has only two columns, for the element number and zone 
number. The final section list the zones that will be compiled and printed to the output file. All 21 zones are 
listed. 

Running the ZBudget program 

Find the file zbudget_SRs.bat and open it with TextPad.  

 

The file begins with two comment lines, one of which describes the zonal configuration of the ZBudget input 
file.  
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In the first command line, the first item ‘..\bin\ZBudget3_02.exe’ points to the ZBudget program in the bin 
directory, and the second item is the name of the ZBudget control file.  

The ZBudget program produces a budget file with the same root name as the input binary file, CVZB.BUD for 
the C2VSim model. This can lead to problems because the ZBudget program is commonly run several times, 
for several different zonal configurations, for each C2VSim scenario. The batch file includes commands to copy 
this generic output file to a file with the same root name as the ZBudget control file, and to copy the 
ZBudgetMessages.out log file to a file with the same root name as the ZBudget control file and the file 
extension ‘.out’.  

The ‘pause’ command at the end of the file causes the command window to remain open so the user can see if 
the program ran to completion. 

Close the ZBudget_SRs.bat file. 

Double-click ZBudget_SRs.bat to run the ZBudget program. 

Review ZBudget results 

When the ZBudget program is run with the ZBudget_SRs.in control file and the ZBudget_SRs.bat batch 
file, two files are created in the Results directory. ZBudget_SRs.BUD has the ZBudget output, and 
ZBudget_SRs.out has the log file.  

ZBudget log file 
Open ZBudget_SRs.out with TextPad. 

 

The ZBudget log file ZBudget_SRs.out is similar to the Budget program log file. It reports that the program 
ran and lists the run time. 

Close ZBudget_SRs.out. 

ZBudget budget file 
Open ZBudget_SRs.BUD with TextPad. 

The ZBudget file is similar to the Groundwater Budget file, but the ZBudget file contains significantly more 
details. The ZBudget output file for the 21 model subregions has 21 tables, one for each subregions. Each 
table begins with two title lines listing the IWFM version and the zone number. This is followed by a four-line 
table header with column titles. The first column has the data and time, and the last column has the 
discrepancy. All of the other columns are paired, with inflow volumes in the left column and outflow volumes 
in the right column.  
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The first 12 (after the data and time) items are repeated in all of the tables in the file; each item has two 
columns, yielding 24 data columns. To the right of these are columns listing the flows between the subject 
zone and adjacent zones. The number of data columns depends on the number of adjacent zones. 

Each row of the ZBudget file has a complete water balance. If the values are added up, with the correct sign 
applied for inflow and outflow, the sum will equal the value in the Discrepancy column. 

The characters 'IWFM' are repeated at the beginning of each zonal section, making it easy to step through the 
file. We can use ‘Find’ to quickly move through the file. Press the <F5> key and enter the letters ‘IWFM’, then 
his return. Then use <Ctrl-F> to move to the title are for each zone. 

Close the ZBudget_SRs.BUD file. 
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Import ing C2VSim Results to Excel 

The IWFM Excel Tools contain a utility to import C2VSim budget files into Excel workbooks. It is generally 
much easier to work with the Excel version of a budget table than with the text version. 

To begin, open Excel and create a new blank workbook.  

Follow the instructions in the section Budget-to-Excel above to open the CVBudget.in file, select 
"Groundwater Budget", and then select "Transfer to Excel". The Groundwater Budget is transferred to the 
open Excel workbook, with one tab for each subregion (1 to 22). Close the ‘Budget to Excel (3.02)’ window. 
Save the Excel workbook as ‘Groundwater Budget.xlsx’. 

Groundwater Budget.xlsx 
Go to the far left tab, labeled ‘Subregion 1 (DSA 58)’, and compare the values to those in the file 
CVground.BUD (open this file in TextPad). The columns, text and values in the two versions should be 
identical. 

Making a Graph 
Next, we will make a graph of ‘Gain from Stream’ for subregion 1.  

First, select cells F6- F449. Then go to Insert -> Scatter -> Scatter with straight lines 

 

The graph will appear in the middle of the screen. Next, we have to add the series name, format the axes, etc. 

To add the series name, right click on the line in the graph and choose Select Data. This will open the ‘Select 
Data Series’ panel. Select ‘Series1’ and then Edit. This will open the ‘Edit Series’ window. Click the box with 
the red arrow, next to the white box below ‘Series name:’, and then select call F5. Click the box with the red 
arrow, next to the white box below ‘Series X values:’ and select cells A6-A449. Then click ‘OK’ to close the 
‘Edit Series’ window, and click ‘OK’ again to exit the ‘Select Data Source’ panel. 

Move the graph to its’ own worksheet page by right-clicking in graph and selecting Move Chart then New 
Sheet. 
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Nex, we can format the x-axis for a yearly time step. Right-click on the x-axis and select ‘Format axis…’ to 
open the ‘Format Axis’ panel. Change the radio button from ‘Auto’ to ‘Fixed’ for ‘Minimum’, ‘Maximum’, 
‘Major unit’ and ‘Minor unit’. Then set the value of ‘Maximum’ to ‘26603’ (the value for 10/31/1972), the 
value of ‘Minimum’ to ‘40086’ (the value for 9/30/2009), the value of ‘Maximum unit’ to ‘3652.5’ (or 5 years), 
and the value of ‘Minor Unit’ to ‘365.25’ (one year). Then select ‘Number’ in the left panel, uncheck the box 
next to ‘Linked to source’, and change the text in the ‘Format code:’ box to ‘mm/yyyy’ and then click the ‘Add’ 
box. Next select ‘Alignment’ in the left pane and use the ‘Text Direction’ drop-down menu to select ‘Rotate all 
text 270o’. Then click on the ‘Close’ button to close the ‘Format Axis’ panel. 

Next we can format the y axis. Right-click on the y-axis and select ‘Format axis…’ to open the ‘Format Axis’ 
panel. In the bottom part of the ‘Axis Options’ panel, change the value for ‘Axis value’ to ‘-1e7’. Select 
‘Number’ in the left panel, uncheck the box next to ‘Linked to source’, change the number next to ‘Decimal 
places’ (near the top of the panel) to zero, and check the box ‘Use 1000 separator (,)’, and then click the ‘Add’ 
box. 
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Creating a Water Year table 
We will make a water year table of the ‘Gain from Stream’ values for subregion 1. 

First, click on the ‘WY-Month’ button in the IWFM Tools ribbon to bring up the ‘WY-Month’ window. Click in 
the ‘Data Range’ area and then use the mouse to select the dates range A6-A449. Next, click in the ‘Time 
Series Data Range’ area and use the mouse to select the data range F6-F449. Click in the ‘Output Range’ area 
and use the mouse to select cell U6. Set the ‘Decimal Digits’ value to zero, and check the three boxes at the 
bottom of the panel. Click ‘OK’ to create the table and graphs. 

Using this table and graphs, monthly and long-term patterns of stream-groundwater flows are easier to see. 
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The C2VSim ArcGIS GUI 

The C2VSim ArcGIS GUI was recently developed to facilitate working with the C2VSm model input files and 
results. The C2VSim ArcGIS GUI is in beta release. Keep this in mind when working with this tool: save your 
work frequently and keep backups of important files.  

The C2VSim ArcGIS GUI works with two linked files, an ArcMap project file (with an mxd extension) and a 
geodatabase. Double-click on the C2VSim_CG_1972IC_R366.mxd project file to open it. 

Add a Background 

The ArcMap project file C2VSim_CG_1972IC_R366.mxd is distributed without an associated background 
file. You can add the dynamic world imagery and world topographic maps backgrounds using layer files.  

First, right-click on Layers and choose Add data. Navigate to the two layer files World_Imagery.lyr and 
World_Topo_Map.lyr and select them, then click the ‘Add’ button. 

 

Change the order of the items 

The Table of Contents pane shows the model components that are available for display. The item at the top in 
the Table of Contents appears at the top in the viewing window, the next item in the Table of Contents 
appears beneath the top item in the viewing window, etc. The ArcMap project file Table of Contents lists the 
items in the order that they were assembled when the project file was created. It is generally useful to re-
arrange them so wells are on top, followed by river nodes, river reaches, nodes, elements, small-stream 
watersheds and subregions.  

In the Table of Contents, drag the items into this order, and then save the project file. 

1) Calibration well 
2) Production well 
3) StreamNode 
4) Node 
5) StreamReaches 
6) Element 
7) Subregion 
8) Small_Watersheds 
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ArcGIS overview 

This section provides a brief introduction to some key ArcMap features and tools. You can skip to the next part 
if you are familiar with ArcMap.  

Table of Contents 
All of the coverages and shapefiles that make up a project are listed in the Table of Contents. The visibility of 
items is also controlled using the Table of Contents. Items with a check mark to their left are visible, and items 
without a check mark are invisible.  

 

In the Table of Contents above, the StreamReaches, Element, Subregion, SmallWatershed and World_Imagery 
layers are visible. The StreamNode, Node, CalibrationWell and ProductionWell layers are not visible. 

Turn the selection box for Subregion off (click in the white box to remove the check mark) and the Subregion 
items will become invisible. Turn the selection box for Subregion on (click in the white box again to add the 
check mark) and the Subregion items will reappear.  

‘Zooming’ in and out 
The magnifying glass tool with the ‘+’ mark in the center allows you to zoom in or out. Select the ‘+’ 
magnifying glass in the toolbar. Use the magnifying glass and left mouse button to draw a square around an 
area. When you release the mouse button, ArcMap will zoom in to the selected area.  Select the ‘-‘ magnifying 
glass in the toolbar. Use this magnifying glass and the left mouse button to draw a square. When you release 
the mouse button, ArcMap will zoom out in proportion to the size of the area you selected. 

Moving around 
The hand-shaped tool in the ArcMap toolbar is called the ‘pan’ tool. With this tool, you can move the picture 
inside the ArcMap frame to see other parts of the coverages. Select the hand tool, click inside the map, and 
slide the mouse to one side as you hold the mouse button. 

Returning to the previous view 
Sometimes you move the map to see something, and then want to go back to the area you were previously 
viewing. ArcMap refers to these views as ‘Extents’. There are two blue arrows in the tool bar, one pointing left 
and one pointing right. Click on the left one to go to the previous view, and then click on the right one to go 
to the next extent.  

‘Zoom’ to see the entire model 
To see the entire model, right-click on Subregion in the Table of Contents and select 'Zoom to layer' 



C2VSim Hands-On Tutorial DRAFT: Not for Public Release 1/22/13 

43 
 

Changing Subreion properties 
The colors, thicknesses and other properties of layers are controlled through ArcMap’s ‘Properties’ controls. 
Double-click on Subregion in the Table of Contents to bring up the ‘Layer Properties’ control panel.  

Select the ‘Display’ tab. The box next to ‘Transparent:’ should have a zero. Change this to ‘70’ and click 
‘Apply’ in the lower right corner of the panel. You should now be able to see through the Subregion items.  

Select the ‘Labels’ tab. Click in the box at the upper left next to ‘Label features in this layer’ to turn labeling 
on. Click on the drop-down menu in the ‘Text String’ area next to ‘Label Field:’ and select ‘Subregion_ID’. Use 
the items in the ‘Text Symbol’ area to change the font properties to red, bold, 12 point. Click ‘Apply’ in the 
lower right corner of the panel. You should now be able to see the Subregion numbers. 

Select the ‘Symbology’ tab. This is where you can change the colors and thicknesses of items. We will leave 
the default settings in place for now. 

Click ‘OK’ to exit the ‘Layer Properties’ panel. 

Changing stream reach properties 
Double-click on Streamreaches in the Table of Contents to bring up the ‘Layer Properties’ control panel. 

Select the ‘Symbology’ tab. In the left pane, choose ‘Categories’. In the dropdown under ‘Value Field’ choose 
‘ReachID’. The box in the middle will show one line for each river reach. Position the mouse pointer over any 
one of the reaches, right-click and select ‘Properties for all symbols’. The ‘Symbol Selector’ panel will open. On 
the right side of this panel, set the number in the box next to ‘Width:’ to 3.00, and then click on ‘OK’ to close 
the ‘Symbol Selector’ window.  

Select the ‘Labels’ tab. Click in the box at the upper left next to ‘Label features in this layer’ to turn labeling 
on. Click on the drop-down menu in the ‘Text String’ area next to ‘Label Field:’ and select ‘Reach_ID’. Use the 
items in the ‘Text Symbol’ area to change the font properties to ultra blue, bold, 12 point. (When selecting the 
color, hold the mouse pointer over a color for a second and a pop-up with the color name will appear.) Click 
‘OK’ in the lower right corner of the panel to close the panel. You should now be able to see the Reach 
numbers. 

Use these stream reach numbers with the reach table in the C2VSim User Manual to identify these reaches. 

Quickly turning labels on and off 
Subregion and stream reach numbers were turned on above. To turn Subregion labels off, right-click on 
Subregion. There is a check box next to ‘Label Features’. Highlight ‘Label Features’ with the cursor and let go 
of the mouse button to switch the mode of the labels, from off to on or from on to off. Do the same for the 
StreamReaches layer. 

Another way to ‘zoom’ 
In the Table of Contents, right-click on Subregion and select ‘Open attribute table’. This will open a table will 
all of the items in the Subregion coverage. Find the row that has ‘4’ in the column labeled ‘Subregion_ID’. 
Click with the left mouse button in the tiny gray box on the left end of this row to select subregion 4. Then put 
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the mouse cursor in the tiny gray box on the left end of this row again, and right-click. Choose ‘Zoom to 
selected’ in the pop-up menu. ArcMap will zoom in or out so this subregion is in the center of the window. 

Click on the ‘Table of Contents’ tab at the bottom of the pane to return to the Table of Contents. Right-click 
on Subregion and select ‘Zoom to Layer’ and ArcMap will show the entire C2VSim model centered in the 
window. 

 

C2VSim Framework 

The basic building block of the C2VSim model is the nodes. To see the nodes, turn on the check box next to 
the Node layer. (You may want to turn off other layers, and/or change the color through the ‘Properties’ 
panel.)  

The nodes are used to construct elements. To see the elements, turn on the check box next to the Element 
layer.  

The rivers are delineated using river reaches and river nodes. River nodes are at the same locations as model 
nodes. River reaches link river nodes into a flow network. To see the river nodes, turn on the check box next to 
the StreamNode layer. To see the river reaches, turn on the check box next to the StreamReaches layer.  

Elements are grouped into subregions for water budget calculations. Turn on the check box next to the 
Subregion layer to see the subregions.  

Surface water flow from ungaged watersheds adjacent to the model boundary are calculated using small-
stream watersheds. Turn on the check box next to the Small_Watersheds layer to see these. 

 

Running C2VSim 

The C2VSim ArcGIS GUI can be used to run the C2VSim model, and C2VSim results can be loaded into a 
geodatabase and viewed through the GUI. Running a model and loading the results are too time-consuming 
for this tutorial, but are covered in the C2VSim ArcGIS GUI manual, accessable through the GUI’s ‘Help’ menu.  
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 Viewing C2VSim Results 

Open the ArcMap project file C2VSim_CG_1972IC_R366.mxd if it is not already open.  

Open the C2VSim ArcGIS GUI with the icon in the menu bar:   

Under the ‘File’ menu, select ‘Use Current’. 

 

This will tell the GUI to use the geodatabase that contains results from running the C2VSim coarse-grid model 
and 1972 initial condition. The GUI’s ‘Analysis’ tab will be visible. 

 

Next, we need to choose an item to analyze. 

  



C2VSim Hands-On Tutorial DRAFT: Not for Public Release 1/22/13 

46 
 

Creating a Graph 
In the ‘Table of Contents’ panel, right-click ‘Subregion’, select the ‘Selection’ option, and then ‘Make This The 
Only Selectable Layer’. 

 

Next, select subregion 20. This can be done by dragging out a small rectangle inside the subregion using the 
‘Select Features by Rectangle’ tool (the white arrow), or by right-clicking on Subregion in the Table of 
Contents, opening the attribute table and selecting the subregion. 

After selecting the subregion, press the ‘Graph’ button in the C2VSim GUI window. This opens the ‘Time Series 
Graph’ panel. Select ‘Groundwater Budget’ in the ‘Time Series Table’ drop-down menu. The ‘Sub-Data Type 
Name’ drop-down menu will become active. Select ‘Pumping’ in the ‘Sub-Data Type Name’ drop-down menu.  

 

Click ‘OK’ and the graph will appear. 
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We can add the monthly subsidence to this graph to see if the relationship between pumping and subsidence 
appears relevant. 

Press the ‘Graph’ button in the C2VSim GUI window again. This opens the ‘Time Series Graph’ panel. 
‘Groundwater Budget’ is already in the ‘Time Series Table’ drop-down menu and ‘Pumping’ is in the ‘Sub-Data 
Type Name’ drop-down menu. Change the ‘Sub-Data Type Name’ drop-down menu to ‘Subsidence’ and click 
‘OK’. The subsidence time series will be added to the graph. 

 

It is difficult to compare the pumping and subsidence to see how they are related. We can move subsidence to 
the right-hand axis. Right-click in the graph and choose ‘Properties…’ from the menu. The ‘Graph Properties 
of Groundwater Budget’ panel will appear. Click in the ‘Subsidence’ tab at the bottom, if it is not already 
selected. Use the drop-down menu next to ‘Vertical Axis”’ to change the vertical axis from ‘Left’ to ‘Right’, 
and click ‘OK’. Subsidence will now be on the right-hand axis, and the relationship between pumping and 
subsidence will be clearer.  
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Exporting Data from a Graph 
The graphing capability of the C2VSim ArcGIS GUI is useful for exploring model results. You may export the 
data in the graph for use in other programs.  

To export the data from the graph, right-click in the graph and choose ‘Export…’ from the menu.  This opens 
the ‘Export Dialog’ panel. There are three tabs at the top: ‘Picture’, ‘Native’ and ‘Data’. Choose the ‘Data’ tab 
an you will see four options in the ‘Format’ section: Text, XML, HTML and Excel. Choose Excel by clicking to 
the left of it. Click ‘Save…’ and navigate to a folder and create an Excel workbook with the data from the 
graph.  

If you quit ArcMap, do not save the project file. 
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Animat ing C2VSim results w ith TecPlot  

This section describes how to view C2VSim results using the TecPlot program. 

Copy the files CVGWheadTecPlot.lay and CVSubsidenceTecPlot.lay to the Results folder of the C2VSim 
3.02-CG Water Years 1973-2009 folder.  

Double-click on the CVGWheadTecPlot.lay file. This should open the TecPlot program and display a color 
map of the water table altitude. It may take a few moments to load the file. The initial condition is for 
midnight 9/30/1972 (which is equivalent to the start of 10/1/1972.) The legend has the name of the output file 
data set ‘GWHEAD1’, which corresponds to the groundwater head of model layer 1. 

 

To create a movie of the change in groundwater head through time, select the ‘Animate’ menu and then 
‘Zones…’. This opens the ‘Animate Zones’ dialog box. 

 

Click on the ‘Animate’ button at the lower left and the animation will run. It may be slow because the 
program re-drawing the map for each time step.  

Use the drop-down menu next to the word ‘Animate’ to select ‘to WMV file’. Click on the ‘Animate’ button in 
the lower left to open the ‘Export’ panel. Click ‘OK’ and navigate to the place you want to save the movie file, 
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name the file, and click ‘Save’. TecPlot may take some time to generate the movie. When TecPlot is finished 
creating the movie file, close the ‘Animate Zones’ panel. Open the folder where you stored the movie file. 
Double-click on the file to open Windows Media Player and run the movie. 

Close TecPlot. 
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Scenar io 1 − GWP: Adding three groundwater  pumping wells 

Description:  This is a fictional case study. Three wells will be added to the C2VSim model at various distances 
from modeled rivers. Each well will pump 2,000 AF/mo for three months, June-August. This example will show 
how to modify the Well Specification File, Pumping Specification File and Pumping Data File to add new wells, 
and how to analyze simulation results. 

We want to pump groundwater from three wells located varying distances from the Sacramento River. We will 
pump 2,000 AF/mo in the summer months (June-August) at each location. For this exercise, we arbitrarily 
selected the three locations in this table: 

Well Latitude Longitude 
A 38.86 -121.72 
B 39.15 -121.45 
C 39.47 -122.20 

 

Set up the project folders 

The first step is to create folders for the groundwater pumping scenario and the unmodified base case.  

1) Create a folder on the Desktop called GWP_Case_Study 
2) Copy the folder C2VSim_CG_1972IC_R367 into the folder GWP_Case_Study and rename it 

GWP_Case 
3) Copy the folder C2VSim_CG_1972IC_R367 into the folder GWP_Case_Study again, and rename 

it Base_Case 

 

Find the well locations using ArcMap 

Next, we will use the ArcMap C2VSim coverage to locate the three wells, determine what model subregion 
and element they are in, and what river reach they are closest to. 

Double-click on the ArcMap project file C2VSim_CG_1972IC_R366.mxd to open it, if it is not already open. 
Right-click on ‘Subregion’ in the ‘Table of Contents’ pane to center the C2VSim model on the screen.  

When using ArcMap, the coordinates of the pointer appear in the lower right-hand corner. 

 

Use the ‘Zoom In’, ‘Pan’ and ‘Select Features by Rectangle’ tools to locate the three wells. Record the model 
element and subregion of each well. Pick the nearest river node to each well and record the river node number 
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and river reach number. You can use the river reach number and a table in the C2VSim User Manualto identify 
the rivers. 

Note: The Glenn-Colusa Canal appears as a modeled river reach in the ArcMap coverage near Well C. The 
Glenn-Colusa Canal is specified in the C2VSim model, but is not simulated. No water flows through this river 
reach and the bottom conductance is set to zero. Ignore the Glenn-Colusa Canal and select a river node on the 
Sacramento River to the east of Well C. 

Well Latitude Longitude Element Subregion River Node River reach 
A 38.86 -121.72 

    B 39.15 -121.45 
    C 39.47 -122.20 
     

Here is the ArcMap window with the location of Well A. The cursor does not appear in the screen-shot, but is 
located just above river node 300. The latitude and longitude are in the lower right. Note the subregion 
number in red, the element boundary and element number in light gray, the river node and river node number 
in dark blue, and the river reach and river reach number in lighter blue. 

 

 

When you are finished, your table should be similar to this: 

Well Latitude Longitude Element Subregion River Node River reach 
A 38.86 -121.72 315 4 300 53 (Sacramento River) 
B 39.15 -121.45 232 5 284 60 (Yuba River) 
C 39.47 -122.20 184 3 202 51 (Sacramento River) 
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Find the well coordinates in UTM zone 10 

We need to enter the well coordinates into the C2VSim model using the UTM zone 10N coordinate system. 
However, the GIS coverage projection uses latitude and longitude. We need to convert the latitude-longitude 
coordinates to UTM zone 10N northing and easting coordinates.  

The file Tools.zip contains an Excel workbook utmconversions.xls, developed by Steve Dutch at the 
University of Wisconsin at Green Bay. This workbook is also available at 
http://www.uwgb.edu/dutchs/usefuldata/utmconversions1.xls. With this workbook, we can convert the well 
coordinates to the format required by the C2VSmi model.  

Open the utmconversions.xls workbook and choose the tab ‘Main Page’. The top section, in red and pink, 
will convert latitude and longitude to UTM coordinates. The middle section, in yellow, will convert UTM 
coordinates to latitude and longitude. 

Use this workbook to determine the UTM 10N coordinates of each well. 

Well Latitude Longitude Easting Northing 
A 38.86 -121.72 

  B 39.15 -121.45 
  C 34.47 -122.20 
   

  

http://www.uwgb.edu/dutchs/usefuldata/utmconversions1.xls�


C2VSim Hands-On Tutorial DRAFT: Not for Public Release 1/22/13 

54 
 

Modify the C2VSim Preprocessor Files 

Make the following modifications to the files in the folder GWP_Case_Study\GWP_Case\Preprocessor: 

Modify the main preprocessor input file 
 1)  Rename file CVpreproc.in to CVpreproc_GWP.in 

 2)  Open file CVpreproc_GWP.in in TextPad 

  2.a)  Add a comment line describing the project 

  2.b)  Change the title line to describe the project 

Leave this file open in TextPad while we work on the other Preprocessor input files.  
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Add the new pumping wells to the preprocessor wells file 
We need to add the three wells to the preprocessor wells file. We will use the Easting value calculated above 
as the X value and the Northing value as the Y value. If you add real wells to the model, you will have some 
idea of the screen interval. PERFTOP and PERFBOT are the altitude in feet of the top and bottom of the 
screened interval. For this exercise we are using fictitious wells, so the screen intervals were arbitrarily chosen. 
The well radius has no significant impact on the simulation results for this model because the element width is 
much larger than the well radius, so RWELL is set to 1.  

 1)  Rename CVWells.dat to CVWells_GWP.dat 

 2)  Open CVWells_GWP.dat in TextPad 

  2.a)  Add a comment line describing the project 

  2.b)  Increase the value of NWELL by 3 

  2.c)  Add three lines at the bottom of the file with the well descriptions: 

WellID X Y RWELL PERFTOP PERFBOT Comment 
134 610971 4302018 1 -50 -100 / GWP Well A 
135 629711 4333940 1 -200 -250 / GWP Well C 
136 568982 4369575 1 -100 -200 / GWP Well C 

 
 3)  Save and close the file  
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Make changes to file CVpreproc_GWP.in 
Once the files have been changed, the file names have to be changed in the preprocessor input file. 

1) Change file name CVWells.dat to CVWells_GWP.dat 
2) Change file name Cvpreout.bin to CVpreout_GWP.bin 
3) Change file name Cvpreproc.in to CVpreproc_GWP.in 
4) Save and close the file  

 

Modify the preprocessor batch file 
The command to run the preprocessor is “PreProcessor3_02.exe CVpreproc_GWP.in”. We generally 
recommend using a batch file to run the IWFM programs. A batch file is provided, but we have to change the 
name of the preprocessor input file before we can use it. 

1) Open the file Run_Preprocessor.bat in TextPad 
2) Change the input file name in Run_Preprocessor.bat to CVpreproc_GWP.in 
3) Save and close the file  

 

 

Run the C2VSim Preprocessor Program 

Now we can run the preprocessor: 

 1)  Double-click on the file Run_Preprocessor.bat 

The preprocessor program should run to completion in a few seconds. It creates two files, 
PreprocessorMessages.out and CVpreout_GWP.bin.  
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Review the preprocessor results 
Open the file PreprocessorMessages.out in TextPad and review it. The three new wells appear in the last 
two tables, the ‘Well Inventory’ and the list of ‘Adjustment Coefficients for Partial Well Penetration’.  

The ‘Well Inventory’ table repeats the X and Y coordinates from in the wells file; it is generally good practice 
to review this information to assure it is correct. This table also lists the element and subregion each well is in. 
Compare these to the element and subregion we determined using ArcMap. The numbers to the right indicate 
how the pumping volume will be apportioned between the nodes of each element. 

The ‘Adjustment Coefficients for Partial Well Penetration’ table lists the element and how the pumping volume 
will be apportioned to model layers. These proportions can be adjusted by changing the well perforation 
interval.  

 

 

Trouble-shooting the preprocessor program 
If the preprocessor program does not run to completion, there is probably a typo in one of the modified input 
files. First, see if the program prints out an error message that points to the error. For example, (a) the file 
name in CVpreproc_GWP.in may not be the same as the actual file name, (b) there may be an extra blank 
line in one of the modified files, or (c) there may be missing or extra characters in one of the modified files. 
Check your work and see if you can find and fix the error.  

If you can’t find the reason the program won’t run, you can use the ‘Compare files’ tool in TextPad to compare 
each of your modified files to the files in the folder GWP_Example_Complete\GWP_Case\Preprocessor. Once 
you find and fix the error, the preprocessor program will run to completion. 

 

  



C2VSim Hands-On Tutorial DRAFT: Not for Public Release 1/22/13 

58 
 

Modify the C2VSim Simulation Files 

Make the following modifications to the files in the folder GWP_Case_Study\GWP_Case\Simulation: 

Modify the simulation input file 
 1)  Rename the file CVsim.in to CVsim_GWP.in 

 2)  Open file CVsim_GWP.in with TextPad 

  2.a)  Add a comment line describing the project 

  2.b)  Change the title line to describe the project 

  2.c)  Change the name of the preprocessor output file to CVpreout_GWP.bin 

 

 

Modify the pumping specification file 
Three new wells were added in the preprocessor well file. We use the pumping specification file to say how 
these wells will be used.  

 1)  Rename the pumping specification file from CVPuSp.dat to CVPuSp_GWP.dat 

 2)  Open CVPuSp_GWP.dat with TextPad 

  2.a)  Add a comment line describing the project 

  2.b)  Add the new pumps to the pumping specification file 

The top section of the pumping specification file holds information on the wells specified in the preprocessor. 
This includes which pumping data column holds the pumping volumes for each well, and which land use and 
subregion the water is supplied to. We will add one row for each of the three new wells.  

1) The first item in each row is the well ID number from the preprocessor well file. 
2) The second item is the column of the pumping data file associated with each well. We will place the 

pumping rates for the three new pumps in three new data columns in the pumping data file. The 
original pumping data file has 42 columns of data, so we will use columns 43, 44 and 45 for the new 
pumps. The ICOLWL values are 43, 44 and 45 for the three wells, respectively. 
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3) The third item specifies the land use type the water is delivered to. This is specified by listing the 
appropriate column of the Irrigation Fraction data file. In the Irrigation Fraction data file, column 22 is 
to deliver 100% to urban use, and column 23 is to deliver 100% to agricultural use. The water from 
the three new pumps will all go to agricultural use, so the ICFIRIWGL value is 23 for all three wells.  

4) The fourth item specifies the percentage of the pumping value to be extracted from this well. We will 
specify a value for reach well, so FRACWL is 1 (or 100%) for all three wells. 

5) The fifth item specifies the subregion the water will be delivered to. The water from each of these 
wells will be used within the subregion the well is in. The three wells are in subregions 4, 5 and 3, 
respectively, so values for IRGWL are 4, 5 and 3. 

6) The last three items specify whether the pumping rates from the three wells will be automatically 
adjusted at run-time. We do not want to adjust the pumping rates from these wells, so we set 
ICADJWL to zero for all three wells. We also have to specify values for the last two items (which will 
be ignored by the program if ICADJWL is zero). We will copy values from the second and fourth 
columns. We set the data column containing the maximum pumping rate (ICWLMAX) to the data 
column containing the specified pumping rate (ICOLWL) and the fraction (FWLMAX) to the specified 
pumping fraction (FWLMAX). 

The final values are: 

ID ICOLWL ICFIRIWGL FRACWL IRGWL ICADJWL ICWLMAX FWLMAX 
134 43 23 1 4 0 43 1 
135 44 23 1 5 0 44 1 
136 45 23 1 3 0 45 1 

 

And when they are entered in the file they look like this: 
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Modify the pumping data file 
We will add the new pumping volumes to the pumping data file in three steps. First, we will copy the pumping 
values from the pumping data file to Excel. Next, we will add three new data columns corresponding to the 
three new wells. Finally, we will copy the modified pumping data set from Excel and paste it into the pumping 
data file, replacing the old data. 

 1)  Rename the pumping file to CVpump_GWP.dat 

 2)  Open the file CVpump_GWP.dat with TextPad 

  2.a)  Add a comment line describing the project 

 2.b)  Change the value of NCOLPUMP  from 42 to 45 (three more data columns) 

 3)  Place your cursor in the left-most position of row 102, before the first ‘C’. 

 4)  Select everything from here to the end of the file (You can use <Shift><Ctrl><End>) 

 5)  Cut this text (Ctrl-X) 

 6)  Open a new Excel workbook 

 7)  Put the cursor in cell A1 and paste the pumping data (Ctrl-V) 

  7.a) Freeze panes with date and header showing 

  7.b) Locate columns 43-45 and color yellow 

  7.c) Add scenario rates and copy down 

  7.d) Copy everything from Excel 

  7.e) Switch to CVpump_GWP.dat in TextPad. Your cursor should still be at line 102. 

  7.f) Paste all of the pumping data (Ctrl-V) 

 8)  Save the CVpump_GWP.dat file 

 

  



C2VSim Hands-On Tutorial DRAFT: Not for Public Release 1/22/13 

61 
 

Modify the printing specification file 
The print specification file lists the locations of the hydrographs that are printed when the model runs. We will 
add some groundwater hydrographs and surface water hydrographs to this file 

1) Rename the print specification file to CVprint_GWP.dat 
2) Open CVprint_GWP.dat with TextPad 
3) Add a comment line describing the project 
4) Add three new groundwater hydrographs 

  4.a) Change the value of NOUTH to 1390 

  4.b) Add the locations of the three new wells, one row each. The first item IOUTHL is the 
layer for the hydrograph, the second item is the X coordinate and the third item is the Y 
coordinate. (You can optionally add an ID and the element number as comments.)  

 

 5) Add three new surface water hydrographs 

5.a) Change the value of NOUTR to 37 

  5.b) Add the locations of the three new hydrographs, one row each. The only required item is 
the river node number IOUTHR. You can optionally add a tag and a comment.  
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Make changes to file CVsim_GWP.in 
Change the input file names in the simulation input file CVsim_GWP.in to match the modified file names 
above. 

1) Change the name of the pumping specification file to CVPuSp_GWP.dat 
2) Change name of pumping file to CVpump_GWP.dat 
3) Change name of the print specification file to CVprint_GWP.dat 

Modify the surface water and groundwater hydrograph and TecPlot output file names in the simulation input 
file CVsim_GWP.in by adding ‘_GWP’ to the root name.  

1) Change CVSWhyd.out  to CVSWhyd_GWP.out  
2) Change CVGWhyd.out  to CVGWhyd_GWP.out 
3) Change CVGWheadTecPlot.out  to CVGWheadTecPlot_GWP.out 
4) Change CVSubsidTecPlot.out  to CVSubsidTecPlot_GWP.out 

In the example below, the comment ‘/** GWP’ has been added to the right of the modified file names. 
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Modify the simulation batch file 
The command to run the simulation is “Simulation3_02.exe CVSim_GWP.in”. We have to change the name of 
the simulation input file in the batch file before we can use the batch file. 

1) Open the file Run_Sim.bat in TextPad 
2) Change the input file name in Run_Sim.bat to CVSim_GWP.in 
3) Save and close the file  

 

 

Run the Simulation Program for the Scenario 

Now we can run the simulation program: 

 1)  Double-click on the file Run_Sim.bat 

The simulation program should run to completion in a few minutes. It creates two files in the Simulation 
folder, SimulationMessages.out and CVfinallist.out. It also creates a number of files in the Results 
folder, including several files with the .bin extension and several files with the .out extension. The .bin files 
are read by two post-processors, the Budget and Z-Budget programs. The .out files are text files that can be 
opened with TextPad. 

Open the file SimulationMessages.out in TextPad and review it. The first section has the title section from 
the CVSim_GWP.in file, followed by a list of the files that were used in the simulation. This is followed by a 
line stating what components were adjusted in this simulation (surface water diversions and groundwater 
pumping); nothing should be adjusted in this simulation. The remainder of the file lists the solver convergence 
iterations for each time step. The last line of the file states the model run time. 

Trouble-shooting the simulation program 
If the simulation program does not run to completion, there is probably a typo in one of the modified input 
files. First, see if the program prints out an error message that points to the error. For example,  

a) the file name in CVSim_GWP.in may not be the same as the actual file name,  
b) there may be an extra blank line in one of the modified files, or  
c) there may be missing or extra characters in one of the modified files.  

Check your work and see if you can find and fix the error.  
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If you can’t find the reason the program won’t run, you can use the ‘Compare files’ tool in TextPad to compare 
each of your modified files to the files in the folder GWP_Example_Complete\GWP_Case\Simulation. Once you 
find and fix the error, the simulation program will run to completion. 

Modify the Base Case files 

The easiest way to see the results of the changes in the case study is to compare the scenario results to the 
unchanged base case. We can replace the print specification file CVprint.dat in the base case with our 
modified print specification file CVprint_GWP.dat. Make the following modifications to the files in the 
folder Base_Case\Simulation. 

Copy the file CVprint_GWP.dat 
Copy the print file CVprint_GWP.dat in the folder GWP_Case_Study\GWP_Case\Simulation and paste it into 
the folder Base_Case\Simulation.  

Make changes to the simulation control file 
Make the following changes to the simulation control file in the folder 
GWP_Case_Study\Base_Case\Simulation: 

1) Rename the file CVsim.in to CVsim_base.in  
2) Open CVsim_base.in with TextPad 
3) Change the print file name to CVprint_GWP.dat 

 

Modify the simulation batch file 
The command to run the simulation is “Simulation3_02.exe CVSim_GWP.in”. We have to change the name of 
the simulation input file in the batch file before we can use the batch file. 

1) Open the file Run_Sim.bat with TextPad 
2) Change the input file name in Run_Sim.bat to CVSim_base.in 
3) Save and close the file  
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Run the Simulation Program for the Base Case 

Now we can run the simulation program: 

 1)  Double-click on the file Run_Sim.bat 

The simulation program should run to completion in a few minutes.  

 

Review and analyze your results 

We’ll use Excel to review the case study. First, we’ll compare items in some Budget files. Then we’ll compare 
the groundwater and surface water hydrographs. 

Base Case Hydrograph Files 
We will open the hydrograph files in TextPad and copy-and-paste them to Excel.  

Base Case Groundwater Hydrographs 
Read and save the Base Case Groundwater Hydrographs 

Browse to the file CVGWhyd.out in directory GWP_Case_Study\Base_Case\Results and open it with TextPad 

Select all (Ctrl-A) and copy (Ctrl-C) 

Open a new Excel workbook and save it in directory GWP_Case_Study as GWP_Results.xlsx 

Put the cursor in cell A1 of tab ‘Sheet1’ and paste (Ctrl-V) 

Move the cursor to cell A5 and select all cells A5-A451 by using the keys <Ctrl><Shift><Down arrow> 

With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’ 

Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. 

We next use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can recognize.  

Use <Ctrl-H> to open the ‘Find and Replace’ panel.  

Next to ‘Find what’, enter ‘_24:00’. 

Leave the ‘Replace with’ field blank. 

Click ‘Replace All’. Excel should open an alert showing the number of replacements. Close the alert and the 
‘Find and Replace’ panel. 

Double-click the tab label ‘Sheet1’ and replace it with ‘GWhyd_Base’ 
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Put the cursor in cell B8 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on the 
drop-down menu ‘Freeze Panes’.  

Scroll to columns BAK through BAM to see the new groundwater hydrographs we added in the print 
specification file. 

Base Case Surface Water Hydrographs 
Read and save the Base Case Surface Water Hydrographs 

Browse to the file CVSWhyd.out in directory GWP_Case_Study\Base_Case\Results and open it with TextPad 

Select all (Ctrl-A) and copy (Ctrl-C) 

Switch to tab ‘Sheet2’ of workbook GWP_Results.xlsx 

Put the cursor in cell A1 of tab ‘Sheet2’ and paste (Ctrl-V) 

Move the cursor to cell A6 and select all cells A6-A450 by using the keys <Ctrl><Shift><Down arrow> 

With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’ 

Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. 

We next use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can recognize.  

Use <Ctrl-H> to open the ‘Find and Replace’ panel.  

Next to ‘Find what’, enter ‘_24:00’. 

Leave the ‘Replace with’ field blank. 

Click ‘Replace All’. Excel should open an alert showing the number of replacements. Close the alert and the 
‘Find and Replace’ panel. 

Double-click the tab label ‘Sheet2’ and replace it with ‘SWhyd_Base’ 

Put the cursor in cell B7 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on the 
drop-down menu ‘Freeze Panes’.  

Scroll to columns AJ through AL to see the new surface water hydrographs we added in the print specification 
file. 

 

GWP Case Hydrograph Files 
We will open the hydrograph files in TextPad and copy-and-paste them to Excel.  

GWP Case Groundwater Hydrographs 
Read and save the GWP Case Groundwater Hydrographs 
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Browse to the file CVGWhyd_GWP.out in directory GWP_Case_Study\GWP_Case\Results and open it with 
TextPad 

Select all (Ctrl-A) and copy (Ctrl-C) 

Add a new worksheet (automatically named ‘Sheet3’) in the Excel workbook GWP_Results.xlsx 

Put the cursor in cell A1 of tab ‘Sheet3’ and paste (Ctrl-V) 

Move the cursor to cell A5 and select all cells A5-A451 by using the keys <Ctrl><Shift><Down arrow> 

With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’ 

Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. 

We next use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can recognize.  

Use <Ctrl-H> to open the ‘Find and Replace’ panel.  

Next to ‘Find what’, enter ‘_24:00’. 

Leave the ‘Replace with’ field blank. 

Click ‘Replace All’. Excel should open an alert showing the number of replacements. Close the alert and the 
‘Find and Replace’ panel. 

Double-click the tab label ‘Sheet3’ and replace it with ‘GWhyd_GWP’ 

Put the cursor in cell B8 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on the 
drop-down menu ‘Freeze Panes’.  

Scroll to columns BAK through BAM to see the new groundwater hydrographs we added in the print 
specification file.  

GWP Case Surface Water Hydrographs 
Read and save the GWP Case Surface Water Hydrographs 

Browse to the file CVSWhyd_GWP.out in directory GWP_Case_Study\GWP_Case\Results and open it with 
TextPad 

Select all (Ctrl-A) and copy (Ctrl-C) 

Create a new worksheet (automatically called ‘Sheet4’) in workbook GWP_Results.xlsx 

Put the cursor in cell A1 of tab ‘Sheet4’ and paste (Ctrl-V) 

Move the cursor to cell A6 and select all cells A6-A450 by using the keys <Ctrl><Shift><Down arrow> 

With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’ 
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Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. 

We next use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can recognize.  

Use <Ctrl-H> to open the ‘Find and Replace’ panel.  

Next to ‘Find what’, enter ‘_24:00’. 

Leave the ‘Replace with’ field blank. 

Click ‘Replace All’. Excel should open an alert showing the number of replacements. Close the alert and the 
‘Find and Replace’ panel. 

Double-click the tab label ‘Sheet4’ and replace it with ‘SWhyd_GWP’ 

Put the cursor in cell B7 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on the 
drop-down menu ‘Freeze Panes’.  

Scroll to columns AJ through AL to see the new surface water hydrographs we added in the print specification 
file. 

 

Compare Base Case and GWP Hydrographs 
We can use Excel to compare the groundwater hydrographs and surface water hydrographs of the two cases.  

Compare Groundwater Hydrographs 
Create a new worksheet (automatically called ‘Sheet5’) in workbook GWP_Results.xlsx and rename it 
‘GWhyd_compare’. 

We want to put the dates into the left-most column. We can copy them from one of the groundwater 
hydrograph worksheets.  

Go to tab ‘GWhyd_Base’ and click in the gray box ‘A’ at the top of the left-most column to select the entire 
column. Use <Ctrl-C> to copy the column. 

Go to tab ‘GWhyd_compare’ and put the cursor in cell A1. Use <Ctrl-V> to paste the column of dates. 

Next we want to calculate the difference between the groundwater hydrographs at the three wells we created. 

Place the cursor in cell B8 (to the right of date 10/31/1972) and press ‘=’ to start a new formula. Without 
hitting return or touching anything else with the cursor, select the tab ‘GWhyd_GWP’ and place the cursor in 
cell BAK8. Then type the minus sign ‘-‘. Again, without hitting return or touching anything else with the 
cursor, select the tab ‘GWhyd_Base’ and place the cursor in cell BAK8. Now hit the return key.  

The cell formula should be “=GWhyd_GWP!BAK8-GWhyd_Base!BAK8” and the value should be zero. 
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Place the cursor in cell B8 and then move the cursor over the small black square that appears in the lower 
right corner of the cell so the cursor changes to a black plus sign. Press the left mouse button and drag the 
small black square to the right to cell D8. This should copy the formula in B8 to cells C8 and D8. 

With cells B8 through D8 highlighted, again move the cursor over the small black square that appears in the 
lower right corner of cell D8 so the cursor changes to a black plus sign. Double-click on the black square to 
copy the formulas down columns B-D to the end of the times in column A. 

The cell values should be zeroes for the first few months, and then should change to small negative numbers. 

Review the Groundwater Hydrograph Differences 
We can use the IWFM Tools WY-Month tool to see the differences between the groundwater pumping case 
and the base case.  

Under the ‘IWFM’ menu, select ‘WY-Month’ to open the ‘WY-Month’ panel. Place the cursor in the ‘Date 
Range’ area and select the dates from column A. Then place the cursor in the ‘Time Series Data Range’ area 
and select the hydrograph values from column B. Put the cursor in the ‘Output range’ are and select cell F8. 
Click the boxes next to the graph for monthly averages, and click ‘OK’. (Annual totals are meaningless for this 
data set, so do not graph them.) 

This will produce a table with the monthly groundwater head difference between the two cases at Well A. As 
we would expect, the water table drops from June through August when the well is pumping, and then rises 
through May.  

 

Compare Surface Water Hydrographs 
We can repeat the same steps to compare the surface water hydrographs. This will give some indication of 
how the increased groundwater pumping affects river flows. Create a new worksheet in workbook 
GWP_Results.xlsx and rename it ‘SWhyd_compare’. 

We want to put the dates into the left-most column. We can copy them from one of the surface water 
hydrograph worksheets.  

Go to tab ‘SWhyd_Base’ and click in the gray box ‘A’ at the top of the left-most column to select the entire 
column. Use <Ctrl-C> to copy the column. 

Go to tab ‘SWhyd_compare’ and put the cursor in cell A1. Use <Ctrl-V> to paste the column of dates. 

Next we want to calculate the difference between the groundwater hydrographs at the three wells we created. 

Place the cursor in cell B7 (to the right of date 10/31/1972) and press ‘=’ to start a new formula. Without 
hitting return or touching anything else with the cursor, select the tab ‘SWhyd_GWP’ and place the cursor in 
cell AJ7. Then type the minus sign ‘-‘. Again, without hitting return or touching anything else with the cursor, 
select the tab ‘SWhyd_Base’ and place the cursor in cell AJ7. Now hit the return key.  

The cell formula should be “=SWhyd_GWP!AJ7-SWhyd_Base!AJ7” and the value should be zero. 
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Place the cursor in cell B7 and then move the cursor over the small black square that appears in the lower 
right corner of the cell so the cursor changes to a black plus sign. Press the left mouse button and drag the 
small black square to the right to cell D7. This should copy the formula in B7 to cells C7 and D7. 

With cells B7 through D7 highlighted, again move the cursor over the small black square that appears in the 
lower right corner of cell D7 so the cursor changes to a black plus sign. Double-click on the black square to 
copy the formulas down columns B-D to the end of the times in column A. 

The cell values should be zeroes for the first few months, and then should change to small negative numbers. 

Review the Surface Water Hydrograph Differences 
We can use the IWFM Tools WY-Month tool to see the differences in river flow between the groundwater 
pumping case and the base case.  

Under the ‘IWFM’ menu, select ‘WY-Month’ to open the ‘WY-Month’ panel. Place the cursor in the ‘Date 
Range’ area and select the dates from column A. Then place the cursor in the ‘Time Series Data Range’ area 
and select the hydrograph values from column B. Put the cursor in the ‘Output range’ are and select cell F7. 
Change the ‘Decimal Digits’ value to zero, and click the boxes next to the graphs for monthly averages and 
annual totals, and click ‘OK’. (Annual totals are relevant for this data set.) 

This will produce a table with the monthly river flow difference between the two cases at river node 300. As 
we would expect, the average flow difference is large for July and August, then less for the each subsequent 
month through January.  

Base Case Budget Files 
We will import the ‘Land and Water Use Budget’, ‘Groundwater Budget’, and ‘Stream reach Budget’ for the 
Base Case to Excel.  

Open a new Excel workbook 

Open the IWFM Budget to Excel Tool by selecting the ‘IWFM’ menu item, then selecting ‘3.02’ in the drop-
down menu next to ‘IWFM version’. 

Browse to the file CVBudget.in in directory GWP_Case_Study\Base_Case\Budget and open it. 

Base Case Land and Water Use Budget 
Choose the ‘Land and water use budget’ and click ‘Transfer to Excel’. 

Save in directory GWP_Case_Study as Base_Land_and_Water_Budget.xlsx 

Base Case Groundwater Budget 
Open a new Excel workbook 

Choose the ‘Groundwater budget’ and click ‘Transfer to Excel’. 

Save in directory GWP_Case_Study as Base_Groundwater_Budget.xlsx 



C2VSim Hands-On Tutorial DRAFT: Not for Public Release 1/22/13 

71 
 

Base Case Stream Reach Budget 
Open a new Excel workbook 

Choose the ‘Stream reach budget’ and click ‘Transfer to Excel’. 

Save in directory GWP_Case_Study as Base_Stream_Reach_Budget.xlsx 

GWP Case Budget Files 
We will import the ‘Land and Water Use Budget’, ‘Groundwater Budget’, and ‘Stream reach Budget’ for the 
GWP Case to Excel.  

Open a new Excel workbook 

Open the IWFM Budget to Excel Tool by selecting the ‘IWFM’ menu item, then selecting ‘3.02’ in the drop-
down menu next to ‘IWFM version’. 

Browse to the file CVBudget.in in directory GWP_Case_Study\GWP_Case\Budget and open it. 

GWP Case Land and Water Use Budget 
Choose the ‘Land and water use budget’ and click ‘Transfer to Excel’. 

Save in directory GWP_Case_Study as GWP_Land_and_Water_Budget.xlsx 

GWP Case Groundwater Budget 
Open a new Excel workbook 

Choose the ‘Groundwater budget’ and click ‘Transfer to Excel’. 

Save in directory GWP_Case_Study as GWP_Groundwater_Budget.xlsx 

GWP Case Stream Reach Budget 
Open a new Excel workbook 

Choose the ‘Stream reach budget’ and click ‘Transfer to Excel’. 

Save in directory GWP_Case_Study as GWP_Stream_Reach_Budget.xlsx 

 

Compare Base Case and GWP Budgets 
We can use Excel to compare the differences in budget components for the two cases.  

Compare Stream Reach Budgets 
Open the Excel workbooks Base_Stream_Reach_Budget.xlsx and GWP_Stream_Reach_Budget.xlsx 

Create a new blank workbook and save it with the name GWP_Stream_Reach_Compare.xlsx 

We want to put the dates into the left-most column. We can copy them from a worksheet in one of the Stream 
Reach Budget workbooks.  
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Go to (for example) tab ‘Stream reach 75’ of GWP_Stream_Reach_Budget.xlsx and click in the box ‘A’ at 
the top of the left-most column to select the entire column. Use <Ctrl-C> to copy the column. 

Go to tab ‘Sheet1’ of GWP_Stream_Reach_Compare.xlsx and put the cursor in cell A1. Use <Ctrl-V> to 
paste the column of dates. Delete the text in cells A1 and A2. 

Next we want to calculate the difference between the budget components for a river reach near one of the 
new wells. We will start with river reach 53, which is near Well A, and we will compare the stream-
groundwater flow between the two cases. 

Place the cursor in cell B8 (to the right of date 10/31/1972) and press ‘=’ to start a new formula. Without 
hitting return or touching anything else with the cursor, select the ‘View’ menu and use the ‘Switch Windows’ 
button to choose the GWP_Stream_Reach_Budget.xlsx workbook and then go to the tab labeled ‘Stream 
reach 53’. Place the cursor in cell H5, then hit the <F4> key three times to remove the ‘$’ signs in the formula. 
Then type the minus sign ‘-‘. Again, without hitting return or touching anything else with the cursor, select the 
‘View’ menu and use the ‘Switch Windows’ button to choose the Base_Stream_Reach_Budget.xlsx 
workbook and then go to the tab labeled ‘Stream reach 53’. Place the cursor in cell H5, then hit the <F4> key 
three times to remove the ‘$’ signs in the formula. Now hit the return key.  

The cell formula should be “='[GWP_Stream_Reach_Budget.xlsx]Stream reach 53'!H5-
'[Base_Stream_Reach_Budget.xlsx]Stream reach 53'!H5’” and the value should be zero. 

Place the cursor in cell B8 and then move the cursor over the small black square that appears in the lower 
right corner of the cell so the cursor changes to a black plus sign. Double-click on the black square to copy the 
formulas down columns B-D to the end of the times in column A. 

The cell values should be zeroes for the first few months, and then should change to negative numbers. 

Add a label in cell B4 such as ‘Stream-Groundwater Flow, Reach 53’. Use <Ctrl-1> to open the ‘Format Cells’ 
panel, choose the ‘Alignment’ tab, and change ‘Horizontal’ to ‘Center’, and place a check next to ‘Wrap text’.  

Review the Differences 
We can use the IWFM Tools WY-Month tool to see the differences between the groundwater pumping case 
and the base case.  

Under the ‘IWFM’ menu, select ‘WY-Month’ to open the ‘WY-Month’ panel. Place the cursor in the ‘Date 
Range’ area and select the dates from column A. Then place the cursor in the ‘Time Series Data Range’ area 
and select the data values from column B. Put the cursor in the ‘Output range’ area and select cell F5. Click 
the boxes next to the graphs for monthly averages and annual totals, and click ‘OK’.  

This will produce a table with the monthly stream-groundwater flow difference between the two cases near 
Well A. The pattern is similar to the difference in stream hydrographs for river node 300 that we produced 
above.  

 



C2VSim Hands-On Tutorial DRAFT: Not for Public Release 1/22/13 

73 
 

Other Budget Components 
We can repeat the same steps to see the differences in any budget component between the base case and 
groundwater pumping scenario.  
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Scenar io 2 - ASR: Aquifer  storage and Recovery  example  

Description: This case study will model a fictitious aquifer storage and recovery program. A specified amount 
of water will be diverted from the Sacramento River in the winter and recharged. The same amount of water 
will then be pumped and used in the summer. This example will show how to modify the Diversion 
Specification File and Diversion Data File to add a surface water diversion, and how to modify the Well 
Specification File, Pumping Specification File and Pumping Data File to add a new well, and how to analyze 
simulation results. 

In this fictional case study, an existing surface water diversion (#65) will be modified so the diversions occur in 
different months from the historical diversions. In this scenario, an additional 1,000 AF/mo will be diverted 
from River Node 371 (west of Sacramento Airport) each month from November through May (7 months = 
7TAF) and will be recharge in element #350, in the Yolo Bypass. The diversion volume will be reduced by 
2,000 AF/mo for June through August, and 1,000 AF/mo for September, so the annual diversion volume will 
remain constant. We will assume this diversion has evaporative losses of 10% and seepage losses of 15%, so 
75% of the diverted water is recharged. A pump will be placed near the recharge basin, and 2,000 AF/mo will 
be pumped for June through August.  

Set up the project folders 

 First, create folders for the base case and the scenario 

  Create a folder on the Desktop called “ASR_Case_Study” 

  Copy the folder C2VSim_CG_1972IC_R366 into the folder ASR_Case_Study and  

  rename it “ASR_Case” 

  Copy the folder C2VSim_CG_1972IC_R366 into the folder ASR_Case_Study again,  

  and rename it “Base_Case” 

 

Open and set up the ArcMap GUI 

We will use the ArcMap C2VSim coverage to view the model components and to find the well coordinates 

 Open the C2VSim model with the C2VSim GUI 

  Double-click on the file C2VSim_CG_1972IC_R366.mxd 

 

 Add a Background 

  Right-click on Layers -> Add data 
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  Select two layer files "World_Imagery.lyr" and "World_Topo_Map.lyr" 

  Add 

 

 Change the order of the items to the following: 

  1) StreamNode 

  2) StreamReaches 

  3) Node 

  4) Element 

  5) Calibration well 

  6) Production well 

  7) Small_Watersheds 

  8) Subregion 

 

Modify the C2VSim files 

Make the following modifications to the files in the folder ASR_Case: 

Modify the main preprocessor input file 
1)  Rename CVpreproc.in to CVpreproc_ASR.in 
2)  Open CVpreproc_ASR.in in TextPad 

  2.a)  Add a comment line describing the project 

  2.b)  Change title line to describe the project 

Use ArcMap and UTMconversions.xls to figure out the X and Y coordinates of our wells 
All of the coordinates for the C2VSim model are specified in UTM zone 10N. For each point, the X value is the 
UTM 10N Northing, and the Y value is the UTM 10N Easting.  

It is very easy to transfer coordinates from the GIS to the C2VSim model If you use coverages with a UTM 10N 
projection. The Northing for a given point is the X value of the point, and the Easting is the Y value. 

The coordinate system of the C2VSim GIS coverages uses degrees latitude and longitude, not the UTM 10N 
projection. We must therefore convert the coordinates from degrees latitude and longitude to UTM 10N 
Northing and Easting before using them in the C2VSim model. A free Excel workbook called 
UTMconversions.xls is available at http://www.uwgb.edu/dutchs/usefuldata/utmconversions1.xls. We can 

http://www.uwgb.edu/dutchs/usefuldata/utmconversions1.xls�
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locate a point in the GIS, enter the latitude and longitude in this workbook, and it will translate these 
coordinates to UTM 10N Northing and Easting. A copy of this workbook is provided in the Tools folder. 

Use ArcMap and UTMconversions.xls to figure out X and Y coordinates (X = Northing, Y = Easting, UTM 10N). 
We will use: 

 RWELL X       Y        PerfTop  PerfBot   Comment 

 1     615460  4281600   -100     -200     / ASR Extraction Well 

 

Add the new pumping wells to the preprocessor wells file 
1)  Rename CVWells.dat to CVWells_ASR.dat 
2)  Open CVWells_ASR.in in TextPad 

  2.a)  Add a comment line describing the project 

  2.b)  Increase the value of NWELL by 1 

  2.c)  Add one line at the bottom of the file with the well description: 

     134  615460 4281600   1         -100    -200      / ASR Extraction Well 
 

 3)  Save and close the file  

Make changes to file CVpreproc_ASR.in 
Once all of the files have been changed, the file names have to be changed in the preprocessor input file. 

1) Change CVWells.dat to CVWells_ASR.dat 
2) Change Cvpreout.bin to CVpreout_ASR.bin 
3) Change Cvpreproc.in to CVpreproc_ASR.in 
4) Save and close the file. 

 

Run the preprocessor program 
The command to run the preproceeor is “PreProcessor3_02.exe CVpreproc_ASR.in”. We generally recommend 
using a batch file to run the IWFM programs. A batch file is provided, but we have to change the name of the 
preprocessor input file before we can use it. 

 1)  Open the file Run_Preprocessor.bat in TextPad 

2)  Change the input file name in Run_Preprocessor.bat to CVpreproc_ASR.in 

 3)  Save and close the file  

Now we can run the preprocessor: 
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 1)  Double-click on the file Run_Preprocessor.bat 

The preprocessor program should run to completion in a few seconds. It creates two files, 
PreprocessorMessages.out and CVpreout_ASR.bin.  

Open the file PreprocessorMessages.out in TextPad and review it. The three new wells appear in the last 
two tables, the Well Inventory and the list of Adjustment Coefficients for Partial Well Penetration. The Well 
Inventory table repeats the information in the wells file; it is generally good practice to review this information 
to assure it is correct. The Adjustment Coefficients for Partial Well Penetration table lists the proportion of 
water that will be extracted from each model layer; these proportions can be adjusted by changing the well 
perforation interval.  

Trouble-shooting the preprocessor program 
If the preprocessor program does not run to completion, there is probably a typo in one of the modified input 
files. First, see if the program prints out an error message that points to the error. For example, (a) the file 
name in CVpreproc_ASR.in may not be the same as the actual file name, (b) there may be an extra blank 
line in one of the modified files, or (c) there may be missing or extra characters in one of the modified files. 
Check your work and see if you can find and fix the error.  

If you can’t find the reason the program won’t run, you can use the ‘Compare files’ tool in TextPad to compare 
each of your modified files to the files in the folder ASR_Example_Complete\ASR_Case\Preprocessor. Once 
you find and fix the error, the preprocessor program will run to completion. 

Modify the simulation input file 
 1)  Rename the file CVsim.in to CVsim_ASR.in 

 2)  Open file CVsim_ASR.in with TextPad 

  2.a)  Add a comment line describing the project 

  2.b)  Change the title line to describe the project 

  2.c)  Change the name of the preprocessor output file to CVpreout_ASR.bin 

 

Modify the diversion specification file 
  Rename the divspec file to CVdivspec_ASR.dat 

   Open CVdivspec_ASR.dat with TextPad 

   Add a comment line describing the project 

 

   Add a diversion to the divspec file 

    NRDV += 1 
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    Change the old diversion (65) 

    ICOLRL = ICOLDL = ICOLDL = 248 

 

    Add the new diversion (247) 

    IRDV = River node 

    FRACRL = 0.90 (recharge volume) 

    FRACNL = 0.10 

    FRACDL = 0.00 (available for ETc) 

    IRGDL  = (Subregion) 

    ICFSIRIG = 23 (Ag) 

 

    Add recharge zone at bottom of file, element #350 

 

  Save the CVdivspec_ASR.dat file 

 

  Change name of the divspec file in CVsim_ASR.in 

    

Modify the diversion data file 
  Rename the diversions file CVdiversions_ASR.dat 

   Open CVdiversions_ASR.dat with TextPad 

   Add a comment line describing the project 

 

  Add a diversion to the diversions file 

   Don't increase NCOLDV, columns 247-250 and 263-264 are unused 

   copy diversions and paste in a new Excel workbook 
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   freeze panes with date and header showing 

   locate columns 65, 247 and 248 and color yellow 

   column 247: put '2' in Nov-May, '0' otherwise 

   column 248: put =MAX(BN2-IN2,0) in cell IO2 and copy down 

   copy from Excel and paste in diversions file and save 

 

  Save the CVdiversions_ASR.dat file 

 

  Change name of diversion file in CVsim_ASR.in 

 

Modify the pumping specification file 
  Rename the pumping specification file to CVPuSp_ASR.dat 

   Open CVPuSp_ASR.dat with TextPad 

   Add a comment line describing the project 

    

  Add the new pump to the pumping specification file 

   ID        = 134 

   ICOLWL    = 43 (new column in pumping file) 

   ICFIRIWGL = 23 (Ag) 

   FRACWL    = 1  

   IRGWL     = (Subregion)  

   ICADJWL   = 1 

   ICWLMAX   = 43 (column number) 

   FWLMAX    = 1 

 

  Save the CVPuSp_ASR.dat file 
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  Change name of pumping specification file in CVsim_ASR.in 

 

Modify the pumping data file 
  Rename the pumping file to CVpump_ASR.dat 

   Open CVpump_ASR.dat with TextPad 

   Add a comment line describing the project 

    

  Add the new pump volume to the pumping file 

   NCOLPUMP  = 43 (new column in pumping file) 

   copy pumping and paste in Excel 

   freeze panes with date and header showing 

   locate column 43 and color yellow 

   add scenario rates and copy down 

   copy from Excel and paste in pumping file and save 

 

  Save the CVpump_ASR.dat file 

 

  Change name of pumping file in CVsim_ASR.in 

 

Modify the printing specification file 
  Rename the print specification file to CVprint_ASR.dat 

   Open CVprint_ASR.dat with TextPad 

   Add a comment line describing the project 

 

  Add some new groundwater hydrographs 

   NOUTH += (n) 
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   IOUTHL = (layer) 

   X and Y 

 

  Add some new surface water hydrographs 

   NOUTR += (n) 

   IOUTHR = (river node) 

 

  Save the CVprint_ASR.dat file 

 

  Change name of the print specification file in CVsim_ASR.in 

 

  Run Simulation3_02.exe CVsim_ASR.in 

   Change the input file name in Run_Simulation.bat to CVsim_ASR.in 

   Double-click on Run_Simulation.bat 

 

 

 Make the following modifications to the scenario in the folder Base_Case (to compare): 

 

  Modify the base case with the new print file 

   Copy the print file CVprint_ASR.dat to the base case simulation folder 

   Copy CVsim.in to CVsim_base.in 

   Change the print file name in CVsim_base.in 

   Change the output file names in CVsim_base.in 

       

  Run Simulation3_02.exe CVsim_base.in 

   Change the input file name in Run_Simulation.bat to CVsim_base.in 
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   Double-click on Run_Simulation.bat 

 

 

Review and analyze your results 

 

  Import Base Case results to Excel 

   Budget files: 

    Use the Excel IWFM tool to import the Land and Water Use budget and 

    the Groundwater Budget 

    Save the excel workbooks with 'ASR_base' in the name 

   Hydrograph files: 

    Open the groundwater hydrographs file CVGWHyd.out with TextPad 

    Select all -> Copy 

    Open a new Excel workbook 

    Paste 

    Select cells A8 down to end 

    Data -> Text to columns -> Delimited -> Space -> Finish 

    Double-click the tab and rename to GWHyd_Base 

     

    Repeat to put the surface water hydrographs file CVSWHyd.out into  

    the same workbook 

    Double-click the tab and rename to SWHyd_Base 

 

    Save the workbook with the name "ASR_Scenario_Hydrographs.xlsx" 

     

  Use Excel to import ASR Case results 
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   Budget files: 

    Use the Excel IWFM tool to import the Land and Water Use budget and 

    the Groundwater Budget 

    Save the excel workbooks with 'ASR_scenario' in the name 

 

   Hydrograph files: 

    Open the ASR case groundwater hydrographs file CVGWHyd.out with  

    TextPad 

    Select all -> Copy 

    Add a new tab to the Excel workbook "ASR_Scenario_Hydrographs.xlsx" 

    Paste 

    Double-click the tab and rename to GWHyd_Scenario 

     

    Repeat with the ASR case surface water hydrographs file CVSWHyd.out 

    into the same workbook 

    Double-click the tab and rename to SWHyd_Scenario 

 

    Save the workbook 

 

 

  Compare the results 

   Compare Land and Water Use Budgets for base and ASR 

    You can do this in several ways: 

     Create a new worksheet, and copy the same budget  

     column from the two scenarios 

     (for example the groundwater pumping columns, or the  
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     gain from stream columns) 

     Subtract the scenario from the base to see the  

     difference each month 

     Graph the scenario and the base 

     Graph the difference between the scenario and the base 

      

   Compare Groundwater Budgets for base and ASR 

   Compare Stream Reach Budgets for base and ASR 

   Compare groundwater hydrographs for base and ASR 

   Compare river hydrographs for base and ASR 
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